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Preface

Welcome to Release 11i of the Oracle Self-Service Time Implementation
Guide.

This manual includes the information you need to implement
Self-Service Time. It contains detailed information about the following:

* Overview and reference information

e Oracle Self-Service Time implementation suggestions

 Specific tasks you can accomplish using Oracle Self-Service Time
e Oracle Self-Service Time functions and features

e Oracle Self-Service Time system setup

The preface explains how this manual is organized and introduces
other sources of information that can help you.
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Audience for This Manual

This manual assumes you have a working knowledge of the following:
e The principles and customary practices of your business area.
» Oracle Self-Service Time
» The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user
interface, read the Oracle Applications User Guide.

For more information about Oracle Applications products, see: Other
Information Sources: page vi.

How To Use This Manual

This manual contains the information you need to understand and use
Oracle Self-Service Time.

This preface explains how this manual is organized and introduces
other sources of information that can help you. This manual contains
the following chapters:

e Chapter 1 describes how to set up Self-Service Time.

e Chapter 2 explains how to customize your implementation to
meet your organization’s needs.

» Chapter 3 describes the PA Timecard Approval Process.

Other Information Sources

You can choose from many sources of information, including online
documentation, training, and support services, to increase your
knowledge and understanding of Oracle Self-Service Time.

If this manual refers you to other Oracle Applications documentation,
use only the Release 11i versions of those guides unless we specify
otherwise.

Online Documentation

All Oracle Applications documentation is available online (HTML and
PDF). The technical reference guides are available in paper format
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Related User Guides

only. Note that the HTML documentation is translated into over
twenty languages.

The HTML version of this manual is optimized for onscreen reading,
and you can use it to follow hypertext links for easy access to other
HTML guides in the library. When you have an HTML window open,
you can use the features on the left side of the window to navigate
freely throughout all Oracle Applications documentation.

* You can use the Search feature to search by words or phrases.

« You can use the expandable menu to search for topics in the
menu structure we provide. The Library option on the menu
expands to show all Oracle Applications HTML documentation.

You can view HTML help in the following ways:

» From an application window, use the help icon or the help menu
to open a new Web browser and display help about that window.

e Use the documentation CD.
e Use a URL provided by your system administrator.

Your HTML help may contain information that was not available when
this manual was printed.

Oracle Self-Service Time shares business and setup information with
other Oracle Applications products such as Oracle Projects. Therefore,
you may want to refer to other user guides when you set up and use
Oracle Self-Service Time.

You can read the guides online by choosing Library from the
expandable menu on your HTML help window, by reading from the
Oracle Applications Document Library CD included in your media
pack, or by using a Web browser with a URL that your system
administrator provides.

If you require printed guides, you can purchase them from the Oracle
store at http://oraclestore.oracle.com.

User Guides Related to All Products

Oracle Applications User Guide

This guide explains how to navigate the system, enter data, and query
information, and introduces other basic features of the GUI available
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with this release of Oracle Self-Service Time (and any other Oracle
Applications product).

You can also access this user guide online by choosing “Getting Started
and Using Oracle Applications” from the Oracle Applications help
system.

Oracle Alert User Guide

Use this guide to define periodic and event alerts that monitor the
status of your Oracle Applications data.

Oracle Applications Implementation Wizard User Guide

If you are implementing more than one Oracle product, you can use the
Oracle Applications Implementation Wizard to coordinate your setup
activities. This guide describes how to use the wizard.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle
Applications development staff. It describes the Oracle Application
Obiject Library components needed to implement the Oracle
Applications user interface described in the Oracle Applications User
Interface Standards. It also provides information to help you build your
custom Oracle Developer forms so that they integrate with Oracle
Applications.

Oracle Applications User Interface Standards

This guide contains the user interface (Ul) standards followed by the
Oracle Applications development staff. It describes the Ul for the
Oracle Applications products and how to apply this Ul to the design of
an application built by using Oracle Forms.

User Guides Related to This Product

viii

Oracle Self-Service Web Applications Implementation Guide

This manual contains detailed information about the overview and
architecture and setup of Oracle Self-Service Web Applications. It also
contains an overview of and procedures for using the Web Applications
Dictionary.
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Managing People Using Oracle HRMS

Use this manual to learn how to enter information about your
employees that use Self-Service Time.

Oracle Payables User Guide

This manual provides information about how approved timecards are
paid in Oracle Payables.

Oracle Projects User Guide

Refer to this guide to learn how Self-Service Time uses the Transaction
Import open interface to integrate with Oracle Projects.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle
Applications development staff. It describes the Oracle Application
Object Library components needed to implement the Oracle
Applications user interface described in the Oracle Applications User
Interface Standards. It also provides information to help you build your
custom Developer/2000 forms so that they integrate with Oracle
Applications.

Oracle Applications User Interface Standards

This manual contains the user interface (Ul) standards followed by the
Oracle Applications development staff. It describes the Ul for the
Oracle Applications products and how to apply this Ul to the design of
an application built by using Oracle Forms 6.

Installation and System Administration Guides

Oracle Applications Implementation Wizard User’s Guide

If you are implementing more than one Oracle product, you can use the
Oracle Applications Implementation Wizard to coordinate your setup
activities. This guide describes how to use the wizard.

Oracle Applications Concepts

This guide provides an introduction to the concepts, features,
technology stack, architecture, and terminology for Oracle Applications
Release 11i. It provides a useful first book to read before an installation
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of Oracle Applications. This guide also introduces the concepts behind,
and major issues, for Applications—wide features such as Business
Intelligence (BIS), languages and character sets, and self-service
applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process
is handled using Oracle One-Hour Install, which minimizes the time it
takes to install Oracle Applications and the Oracle 8i Server technology
stack by automating many of the required steps. This guide contains
instructions for using Oracle One-Hour Install and lists the tasks you
need to perform to finish your installation. You should use this guide
in conjunction with individual product user guides and
implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications
Release 10.7 or Release 11.0 products to Release 11i. This guide
describes the upgrade process in general and lists database upgrade
and product-specific upgrade tasks. You must be at either Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0 to upgrade to
Release 11i. You cannot upgrade to Release 11i directly from releases
prior to 10.7.

Using the AD Utilities

Use this guide to help you run the various AD utilities, such as
Autolnstall, AutoPatch, AD Administration, AD Controller, Relink,
and others. It contains how-to steps, screenshots, and other
information that you need to run the AD utilities.

Oracle Applications Product Update Notes

Use this guide as a reference if you are responsible for upgrading an
installation of Oracle Applications. It provides a history of the changes
to individual Oracle Applications products between Release 11.0 and
Release 11i. It includes new features and enhancements and changes
made to database objects, profile options, and seed data for this
interval.
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Training and Support

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle
Applications System Administrator. It contains information on how to
define security, customize menus and online help, and manage
processing.

Oracle Receivables Applications Technical Reference Manual

The Oracle Receivables Applications Technical Reference Manual contains
database diagrams and a detailed description of Oracle Receivables
and related applications database tables, forms, reports, and programs.
This information helps you convert data from your existing
applications, integrate Oracle Receivables with non-Oracle
applications, and write custom reports for Oracle Receivables.

You can order a technical reference manual for any product you have
licensed. Technical reference manuals are available in paper format
only.

Oracle Workflow Guide

This guide explains how to define new workflow business processes as
well as customize existing Oracle Applications—embedded workflow
processes. You also use this guide to complete the setup steps
necessary for any Oracle Applications product that includes
workflow-enabled processes.

Oracle Applications Flexfields Guide

This manual provides flexfields planning, setup, and reference
information for the Oracle Self-Service Time implementation team, as
well as for users responsible for the ongoing maintenance of Oracle
Applications product data. This manual also provides information on
creating custom reports on flexfields data.

Training

We offer a complete set of training courses to help you and your staff
master Oracle Applications. We can help you develop a training plan
that provides thorough training for both your project team and your
end users. We will work with you to organize courses appropriate to
your job or area of responsibility.

Preface Xi



Training professionals can show you how to plan your training
throughout the implementation process so that the right amount of
information is delivered to key people when they need it the most. You
can attend courses at any one of our many Educational Centers, or you
can arrange for our trainers to teach at your facility. We also offer Net
classes, where training is delivered over the Internet, and many
multimedia—based courses on CD. In addition, we can tailor standard
courses or develop custom courses to meet your needs.

Support

From on-site support to central support, our team of experienced
professionals provides the help and information you need to keep
Oracle Self-Service Time working for you. This team includes your
Technical Representative, Account Manager, and Oracle’s large staff of
consultants and support specialists with expertise in your business
area, managing an Oracle server, and your hardware and software
environment.

Do Not Use Database Tools to Modify Oracle Applications Data

Xii

We STRONGLY RECOMMEND that you never use SQL*Plus, Oracle
Data Browser, database triggers, or any other tool to modify Oracle
Applications tables, unless we tell you to do so in our guides.

Oracle provides powerful tools you can use to create, store, change,
retrieve, and maintain information in an Oracle database. But if you
use Oracle tools such as SQL*Plus to modify Oracle Applications data,
you risk destroying the integrity of your data and you lose the ability to
audit changes to your data.

Because Oracle Applications tables are interrelated, any change you
make using an Oracle Applications form can update many tables at
once. But when you modify Oracle Applications data using anything
other than Oracle Applications forms, you might change a row in one
table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving
erroneous information and unpredictable results throughout Oracle
Applications.

When you use Oracle Applications forms to modify your data, Oracle
Applications automatically checks that your changes are valid. Oracle
Applications also keeps track of who changes information. But if you
enter information into database tables using database tools, you may
store invalid information. You also lose the ability to track who has
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About Oracle

Your Feedback

changed your information because SQL*Plus and other database tools
do not keep a record of changes.

Oracle Corporation develops and markets an integrated line of
software products for database management, applications
development, decision support and office automation, as well as Oracle
Applications. Oracle Applications provides the E-business Suite, a
fully integrated suite of more than 70 software modules for financial
management, Internet procurement, business intelligence, supply chain
management, manufacturing, project systems, human resources and
sales and service management.

Oracle products are available for mainframes, minicomputers, personal
computers, network computers, and personal digital assistants,
enabling organizations to integrate different computers, different
operating systems, different networks, and even different database
management systems, into a single, unified computing and information
resource.

Oracle is the world’s leading supplier of software for information
management, and the world’s second largest software company. Oracle
offers its database, tools, and application products, along with related
consulting, education and support services, in over 145 countries
around the world.

Thank you for using Oracle Self-Service Time and this implementation
guide.

We value your comments and feedback. This manual contains a
Reader’s Comment Form you can use to explain what you like or
dislike about Oracle Self-Service Time or this manual. Mail your
comments to the following address or call us directly at (650) 506—7000.

Oracle Applications Documentation Manager
Oracle Corporation

500 Oracle Parkway

Redwood Shores, CA 94065

U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
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CHAPTER

Setting Up Self-Service
Time

T his chapter describes the steps you need to perform to set up
Self-Service Time. It includes information about setting up
responsibilities, employees, profile options, and the timecard
spreadsheet. It also provides information about interfacing with Oracle
Projects and migrating data from Project Time and Expense (PTE).
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Setting Up Self-Service Time

1-2

Oracle Self-Service Time (SST) is a web application that is fully
integrated with Oracle Projects. Users can enter timecards that will
then be routed for approval using Oracle Workflow. Users can save
partial or complete timecards for later modification and submission,
view and modify old timecards, and create timecards in Excel for later
upload to the database.

Administrative entry is also supported. This means that you can
delegate time entry for all employees to a few administrative users of
Self-Service Time.

This document describes:
* How to set up Self-Service Time

* How to migrate data from Oracle Project Time and Expense and
Oracle Personal Time and Expense to Oracle Self-Service Time

Notes on Terminology and File Locations

e Terminology: In the 11i version of Self-Service Time, the
overriding approver is called the approver.

* File locations: Self-Service Time files are located in
$PA_TOP/patch/115/SQL
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Setting Up Responsibilities and Automatic Approval

You must assign the Timecard responsibility to every user that you
want to be able to enter timecards using Oracle Self-Service Time. You
can also change the level at which automatic approval of timecards is
established.

(Optional) Set Up Additional Responsibilities

Profile options are set at the responsibility level, so you can customize
the use of the Self-Service Time features. Just create copies of the
Self-Service Time responsibility and then configure each responsibility
with different profile option settings. For example, you might want
users assigned to the Timecards responsibility to have their timecards
approved automatically but require users assigned to the Timecards?2
responsibility to have their timecards go through the approval process.

p To set up additional responsibilities:

1. Using the System Administrator responsibility, navigate to the
Responsibilities window.

For this field... Do this...

Responsibility Name Enter a unique name for the responsibility
(for example, Timecards1)

Application Enter Oracle Self-Service Web
Applications

Responsibility Key Enter a unique name (for example,

PA_WEB_TIMECARDSI; if you make
another responsibility, use a different key,
for example PA_WEB_TIMECARDS?2)

Effective Dates Enter a From and To date (To date is
optional)

In the Data Group area:

Name Enter Standard

Application Enter Oracle Self-Service Web
Applications

Table 1-1 Setting up additional responsibilities (Responsibilities window)
2. Select the Securing Attributes tab and then:
e Enter ICX_HR_PERSON_ID in the Name field

e Enter Oracle Self-Service Web Applications in the Application
field

3. Save your work.
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Setting Up Employees

For each employee that will use Self-Service Time, you must enter
information about the employee and set up responsibilities.

Enter Employees

Before employees can use Self-Service Time, you must enter the
following employee information:

Information Window/Tabbed Region/ How Information is used in Self—
Field Name Service Time
Employee Name | People Name that appears in the employee

field in Self-Service Time windows.

Supervisor Assignment/Supervisor The employee’s HR Supervisor. The
default code in the Routing extension
routes the timecard to the supervisor
for approval.

Table1-2

For more details on entering employee information, see: Employees
and Employee Assignments Oracle Projects User’s Guide or, if you use
Oracle Human Resources to enter employees, see: Oracle Human
Resources User’s Guide.

Note: The employee’s organization must match or be within
the operating unit assigned to the employee’s responsibility.

Assign Self-Service Time and Workflow Responsibilities

Before employees can use Self-Service Time they must be defined as
application users and assigned the Timecards and Workflow
responsibilities. See: Users Window in the Oracle Applications System
Administrator’s Guide.

To assign responsibilities:

1. Using the System Administrator responsibility, navigate to the
Users window.

2. Inthe User Name field, query the employee name.

3. Choose the Responsibilities tab and then assign both the Timecards
responsibility and the Workflow responsibility to the employee.

The Timecards responsibility gives the user the ability to access
timecards. The Workflow responsibility gives the user the ability to
view notifications and view progress of workflow
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4. Select the Securing Attributes tab, and then:
e Enter ICX_HR_PERSON _ID in the Attribute field
* Use the list of values in the Value field to select the Person ID

5. Save your work.

Assign Users the Authority to Enter Timecards for Other Employees

You can authorize a user to enter timecards for another employee. An
employee who is able to enter timecards for another employee is called
an authorized delegate. For example, you might want to authorize
executive assistants to enter timecards for their managers.

p Toassign to users the authority to enter timecards for other
employees:

1. Define as applications users any authorized delegates to whom you
want to assign the Timecards and Workflow responsibilities.

2. Using the System Administrator responsibility, navigate to the
Users window.

3. Inthe User Name field, query the name of the authorized delegate.
4, Select the Securing Attributes tab, and then:

e Enter ICX_HR_PERSON_ID in the Attribute field for the
delegate.

« Use the list of values in the Value field to select the Person ID of
the employee for whom you want the authorized delegate to
enter timecards

5. Save your work.

Configuring Profile Options

Profile options set during implementation specify how Self-Service
Time controls access to and processes data. In addition to Self-Service
Time profile options, Self-Service Time uses profile options from:

» Oracle Self-Service Web Applications (prefix ICX)
» Oracle Projects (prefix PA)

* Multiple Organizations (prefix MO). See: Multiple Organizations
in Oracle Applications.
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Note: The prefix for all Self-Service Time profile options is
”PA Time.”

You can configure the profile options at one or more levels, including
Site, Application, Responsibility, and User. For more information, see
the Oracle Applications System Administrator’s Guide.

To set profile options:

1. Using the System Administrator responsibility, navigate to the Find
System Profiles window.

2. Atthe appropriate level, query the profile option that you want to
configure (enter the name of the profile option and choose Find)
and then make an entry at the desired level (Application,
Responsibility, or User).

To set the profile option at this level... | Do this...

Application Select Application and enter Oracle
Self-Service Web Applications

Responsibility Select Responsibility and enter Timecards
(or a different responsibility)

User Select User and enter the user name

Table1-3

Important: When configuring profile options at the application
level, enter Oracle Self-Service Web Applications, not Oracle
Projects.

3. Save your work.

Overview

Table 1 - 4 lists the profile options that affect Self-Service Time. Each
profile option is described in the sections that follow.

The table below indicates whether the ”User” can view or update the
profile option and at which System Administrator levels the profile
options can be updated: at the Site, Application, Responsibility, or User
levels.

A "Required” profile option requires you to provide a value. An
”Optional” profile option provides a default value, so you only need to
change it if you don’t want to accept the default.
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User System Administrator
Profile Option Resp. Responsibility Requirements
User | User Resp App Site |Required? Default Value
ICX: Date Format Mask I I » | Yes DD-MON-RRRR
ICX: Language I I » | Yes American English
ICX: Limit Connect I » | Yes 1000
ICX: Limit Time I ¥ | Yes 4 hours
PA: Override Approver** I I I » | No
PA Time: Allow Entry of » I » | No
Negative Hours
PA Time: Timecard Number » I » | Yes
Prefix
PA Time: Enable Business I I » | No
Message
PA: AutoApprove - I » | No
Timesheets**
PA Time: Self-Service Time » | Yes
Licensed
MO: Operating Unit » | Yes*
I You can update the profile option

*

*%

Yes if multiple organizations are enabled; otherwise, not required
This profile option is shared by Oracle Projects and Self-Service Time (prefix is PA)

Table 1 -4 Profile Options (Page 1 of 1)

ICX: Date Format Mask

Determines the date format. The American English default format is
DD-MON-RRRR (for example, 07-JAN-1999).

For year 2000 compliance, all year formats are converted to RRRR,
which accepts four—digit century and year entries verbatim (for
example, 1950 is stored as 1950). Two-digit year entries of 00 through
49 are converted to 2000 through 2049, and entries of 50 through 99 are
converted to 1950 through 1999.

ICX: Language

Specifies the language used in Self-Service Time. The default is
American English.

ICX: Limit Connect

Sets the maximum number of page hits per session. The default is
1000.
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ICX: Limit Session Time

Sets the maximum number of hours a user can remain logged on, per
session. The default is four hours.

PA: Override Approver

Determines whether users can enter an overriding approver for
timecards.

You can view and update this profile option at the site, responsibility,
application, and user levels.

Internal name: PA_ONLINE_OVERRIDE_APPROVER
Permitted values:

Yes: The Overriding Approver field is visible and users can select an
overriding approver from a list of values. The default list of values
contains all supervisors in the preparer’s business group. A supervisor
is someone who is defined in the HR People-Assignment window.

No or <no value>: The Overriding Approver field is not visible and
users cannot select an overriding approver. The approver is
determined by the Routing extension. See: Using Client Extensions to
Customize Self-Service Time: page 2-12.

Note: After enabling the profile option, configure the Override
Approver view to meet your requirements. See: PA:
Overriding Approver: page 1-8.

PA Time: Allow Entry of Negative Hours

Determines whether users can enter negative hours in the Create New
Timecard screens in Self-Service Time. You can set this profile option
at the site, application, or responsibility level.

Internal name: PA_SST_ALLOW_NEGATIVE_TXN
Permitted values:
Yes: Users can enter negative hours.

No or <no value>: Users cannot enter negative hours.

PA Time: Timecard Number Prefix

You can specify a prefix (up to 5 characters long) to append to the
beginning of the timecard number. For example, if you enter ’DMV”,
the system generates timecard numbers such as DMV1234, DMV1235,
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and so on. You can set this profile option at the site, application, or
responsibility level.

Internal name: PA_SST TC_NUM_PREFIX

<No value>: Display a dash (-) before the timecard number.

PA Time: Enable Business Message

Self-Service Time supports the display of a custom business message in
the Final Review, Timecard Details (View History), Submit,
Confirmation, and Approver Review windows.

This profile option indicates whether the Self-Service Time displays a
business message in the user window. If the profile option is set to Yes,
Self-Service Time calls the Business Message Display client extension
(see: Business Message Display Extension: page 2-22). You can set this
profile option at the site, application, and responsibility levels.

Internal name: PA_SST_ALLOW_ENABLE_BUS_MSG
Permitted values:
Yes: Enable display of custom business message field.

Note: This field displays a value only if the Business Message
Display extension returns a value. Otherwise, the message
field is empty.

No or <no value>: Default value is No (custom business message field
is not displayed).

After you enable the profile option, define the message in Application
Object Library (AOL) using the Application Developer responsibility.
You can use up to three tokens in your message. Use a custom
application name for your message to preserve the message in future
upgrades. For more information about messages, see: Oracle
Application Object Library/Workflow Technical Reference Manual. For
information about customizing the default business message (Billable
Percentage), see: Customizing Messages: page 2-11.

Next, configure the Business Message Display client extension to return
the message defined in AOL with any tokens required. The Business
Message Display Extension contains default code (marked as a
comment) that returns a message displaying the billable percentage for
the timecard. If this meets your requirements, remove the comment
characters from the default code to display the billable percentage
message in the Self-Service Time windows. See: Using Web
Application Dictionary to Customize Reports: page 2-3.
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(Optional) PA: AutoApprove Timesheets

You may decide that you do not need approvals for employee time
entries and want to approve timecards automatically. This profile
option controls whether timecards submitted from Self-Service Time
can be approved automatically.

Internal name: PA_PTE_AUTOAPPROVE_TS
Permitted values:

Yes: The timecard status automatically changes to Approved. You do
not need to route or review your timesheets.

No or <no value>: Default value is No (all timecards require review
and approval).

You can view and update this profile option at the application level.

This profile option integrates with the AutoApproval client extension.
See: Using Client Extensions to Customize Self-Service Time: page
2-12.

PA Time: Licensed

Set this profile option to indicate that Self-Service Time is
implemented. You can set this profile option only at the site level.

Internal name: PA_SST_LICENSED
Permitted values:
Yes: Self-Service Time is implemented and users can enter timecards.

No or <no value>: Default value is No. Self-Service Time is not
implemented and users cannot enter timecards.

MO: Operating Unit

If you use the Multiple Organization Support feature, use this profile
option to assign operating units to responsibilities. See: Multiple
Organizations in Oracle Applications. You can set this profile option at
the responsibility and site level.

Note: Be sure that the employee’s organization matches or is
within the operating unit assigned to the employee’s
responsibility.
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Setting Up Descriptive

Flexfields

Define descriptive flexfields to record additional information in the
Details window during time entry. You can also define custom fields,
called global flexfields, that appear for every hour that a user enters.
These values are stored in the numbered ATTRIBUTE columns in the
PA_ElI_DENORM table, ATTRIBUTEL 1to ATTRIBUTE1 10 through
ATTRIBUTE7_1to ATTRIBUTE7_10. This represents 10 segments for
each day of the week.

You can also define context—sensitive flexfields that appear only when a
user selects a particular type. For example, when selecting Overtime —
Professional in the Type field, a custom field appears for Overtime
Approved By. Context-sensitive fields can be based only on the
expenditure type or the expenditure type class.

Oracle Self-Service Time and Oracle Projects share the same set of
descriptive flexfields. They are enabled or disabled in both
applications at the same time.

For detailed information about defining descriptive flexfields, see:
Oracle Applications Flexfields Guide. The following discussion provides
some tips for defining descriptive flexfields.

Prerequisites

Plan the global and context—sensitive flexfields you need. Remember
that you can use ten Attribute columns, so using global data element
fields reduces the number of Attribute columns available for
context-sensitive fields. See: Flexfield Concepts Oracle Applications
Flexfields Guide.

To set up descriptive flexfields:

1. Using the System Administrator responsibility, navigate to the
Descriptive Flexfields Segments window (Application> Flexfield >
Descriptive > Segments).

Specify the Expenditure Type Class or Expenditure Type values for
which you want to display additional flexfields. For more
information on this window, see: Descriptive Flexfield Segments
Window in the Oracle Applications Flexfields Guide.

« For Application, query Oracle Projects.

« For Title, query Expenditure Items.
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» For Reference Field, enter either
SYSTEM_LINKAGE_FUNCTION (used for Expenditure Type
Class) or EXPENDITURE_TYPE.

2. Inthe Context Field Values area, enter a line for each Expenditure
Type Class or Expenditure Type for which you want to display
unique custom fields. For example:

* Code: OT
* Name: OT
» Description: All overtime requires approval

Important: Context-sensitive flexfields do not appear in
Self-Service time unless you enter the Context Field Values in
the Code field exactly as they have been defined and stored in
the PA_ONLINE_EXPENDITURE_TYPES_V view. The Name
and Description fields contain values that you create.

3. Choose Segments to display the Segments Summary window.

Use this window to define the segments for the global data element
context (global flexfields) and each context field value (context
sensitive flexfields).

4. Define the fields you want to appear and the values the users can
enter for the field:

» For Value Set, enter the specific values the user must enter (if
any), and then choose Open.

» For Default Type, if you enter a value other than Constant, you
must customize the
PA_CLIENT_EXTN_SST_DFFRPOPULATEDFLEXDEFAULT
client extension. See: Using Client Extensions to Customize
Self-Service Time: page 2-12.

Note: Unlike Self-Service Expenses, the Description field is
optional for Self-Service Time. All enabled descriptive
flexfields appear in both Self-Service Time and Oracle Projects.

For more information on the Segments Summary window, see:
Context Field Values Oracle Applications Flexfields Guide.

5. To define valid values for the field, first define a value set by
entering a unique name for the value set. To do this, choose the
Value Set button. In the Value Sets window, set the options you
want:

 Select Enable Longlist for very long lists, for example, a list of
employees. If you enable this option, the custom field appears as
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a text field. If you want the field to display a poplist with all
possible values, disable this option. Disable this option only for
small lists, because long poplists slow performance.

« To validate the format of data entered in the field, specify
validation criteria in the Format Validation area.

« To validate the format of data entered in the field, specify
validation criteria in the Format Validation area. Choose from
the following validation types:

— Numbers only

Uppercase only

Format type character

- Maximum size
e For Validation Type, select Independent, None, or Table:
— Independent: flexfield appears as a poplist
— None: flexfield appears as text
— Table

— Checklist: If you want the value to appear as a check
box instead of the default described below, assign the
PA SRS YES NO_LOV value set for that particular
custom option.

— Poplist: If the select statement does not contain bind
variables, the list of values values is generated
automatically. However, if it does contain bind
variables, use the client extension to define the list of
values. See: Using Client Extensions to Customize
Self-Service Time: page 2-12.

Note: If you want the value to appear as a check box
instead of the default described below, assign the
PA_SRS_YES_NO_LOV value set for that custom
option.

If the select statement does not contain bind variables, the system
generates a list of values values automatically. However, if the
statement does contain bind variables, use the client extension to
define the list of values. See: Using Client Extensions to Customize
Self-Service Time: page 2-12.

For more information, see: Defining Value Sets in the Oracle
Applications Flexfields Guide.
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6. Save your work.

7. If you have defined a value set with independent validation type,
navigate to the Segment Values window (Application > Flexfield >
Descriptive > Values), then define and enable the valid values for
the new fields you are defining. For more information, see:
Segment Values Window in the Oracle Applications Flexfields Guide.

8. Save your work, return to the Segments window, enable the new
fields, and then save again.

9. Return to the Descriptive Flexfield Segments window. Enable the
Context Field Values you want to use and then check the Freeze
Flexfield Definition box. Choose the Compile button to compile the
descriptive flexfield definition.

Customizing Flexfield Routines

Self-Service Time provides routines that you can customize. The
routines are included in the $PA_TOP/patch/115/sql/PAPSSDFB.pls
file, in the PA_CLIENT_EXTN_SST_DFF package. See: Notes on
Terminology and File Locations: page 1-2.

Self-Service Time provides a "hook” to each of these routines. You can
edit them to provide custom, default values, and poplist values.

Note: You are responsible for the support and upgrade of the
logic within these two procedures, which may be affected by
database or other changes between releases of Oracle
Applications. Make a copy of all custom code and place itin a
directory protected from upgrade. After an upgrade, if
appropriate, reapply any custom code.

The routines you can customize are:

* POPULATEDFLEXPOPLIST — Customize this procedure to
generate custom poplist values. Instead of using the value set
values you define in the Segment Values window for value sets
with independent validation, you can provide a subset of those
values in the poplists. For more information, see: Custom
Populate Descriptive Flex Poplist: page 2-24.

Note: If the select statement does not contain bind variables,
the system generates the poplist values automatically.
However, if it does contain bind variables, use the client
extension to define the poplists.

* POPULATEDFLEXDEFAULT - Customize this procedure to
generate custom default values based on the user’s ID instead of
the value defined in the Default Value field in the Segments
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window. You can customize this procedure to provide defaults
for custom fields based on information in the Timecard
Information page or other area of Self-Service Time, such as the
Employee name or Week Ending date. For more information,
see: Custom Default Descriptive Flex Poplist: page 2-26.

Setting the Week Ending Day

Self-Service Time uses the Expenditure Cycle Start Day that you set up
when implementing Oracle Projects to determine the Week Ending Day.
If you specify Monday as the expenditure cycle start day, the week
ending date is the following Sunday. You can choose any day of the
week as your expenditure cycle start day.

Note: Once itis set up, you cannot change the expenditure
cycle start day.

Setting Charge Controls

Self-Service Time uses the following charge controls (set up in Oracle
Projects):

e Project Status: Indicates if any charges are allowed for the
project.

» Task Chargeable Status: Specifies a lowest task as chargeable or
non-chargeable (indicates whether any charges are allowed for
the task).

« Start and Completion Dates: Specifies the start and completion
dates of a lowest task to record the date range for which charges
are allowed for the task. The start and completion dates of the
project also limit when transactions can be charged.

« Transaction Controls: Specifies the type of transactions that are
chargeable or non—chargeable for the projects and tasks. See:
Transaction Controls in the Oracle Projects User Guide.

Setting Up Self-Service Time 1-15



Setting Up the Spreadsheet for Offline Entry

Some Self-Service Time users may not have access to Self-Service Time
when away from the office. These employees can record their time in a
spreadsheet and then upload the spreadsheet into Self-Service Time
upon returning to the office.

Self-Service Time provides a predefined Microsoft Excel (.xIs) file you
can use to enter hours. To use the predefined spreadsheet with
Self-Service Time, you must use Excel 5.0 or higher. The spreadsheet
uses Visual Basic objects to create entries for the Type field and Visual
Basic objects are not supported in earlier Excel versions.

Prerequisites

[ Install Microsoft Excel 5.0 or higher.

[0 Copy the spreadsheet file from /OA_HTML/<language> virtual
path to a separate directory protected from upgrade.

p To set up the spreadsheet for offline entry:
1. Open and unprotect the spreadsheet: page 1-16.

The predefined .xIs file (pawtimes.xls) is located in
$PA_TOP/html/US and is copied to /OA_HTML/<language>
virtual path on your Web Server during installation.

Format the Week Ending date field: page 1-17.
Populate the options in the Type field: page 1-17.
Change the Week Ending Day: page 1-18.

Create cell links: page 1-19.

Change prompts: page 1-20.

Set up global descriptive flexfields: page 1-20.

© N o g~ DN

Protect the spreadsheet and check your work: page 1-24.

@ Suggestion: Save your work periodically.
Open and Unprotect the Spreadsheet

The spreadsheet is protected from unauthorized changes. Before you
start, you must unprotect (unlock) it.
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» To open and unprotect the spreadsheet:

1. Open the spreadsheet file (pawtimes.xls) and display all
worksheets tabs. To do this, choose Options from the Tools menu,
choose the View tab, and then check the Sheet Tabs check box.

The predefined spreadsheet includes five worksheets: Timecard,
Types, Other Setup, Cell Links, Prompts, and Timecard Flexfield
Example.

2. Unlock the spreadsheet so you can edit it. To do this, choose
Protection from the Tools menu, then choose Unprotect Sheet.

Format the Week Ending Date Field

p To format the Week Ending date field:

1. If necessary, select the Timecard worksheet tab.

2. Format the Week Ending date field with the date format used in
Oracle Applications. To do this, select the cell to format, then
choose Format>Cells>Custom. Then, select the appropriate date
format.

For example, if your date format in Oracle Applications is
DD-MON-RR, set the date format to DD-MON-YY for the Week
Ending field. Similarly, if the date format in Oracle Applications is
DD-MON-RRRR, set the date format to DD-MON-YYYY.

Additional Information: See: ICX: Date Format Mask: page

=] 17

Populate the Options in the Type Field

The system generates the Type options in the Timecard worksheet from
the values in Column A of the Types worksheet.

p To populate the options in the Type field:

1. The Types worksheet contains predefined values as examples.
Add, delete, or change these values as required.
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To...

Do this...

Add a Type

Insert a row in the middle of the list and
then enter the new Type to add.

Note: Do not add rows to the bottom of
the list of defined values. To keep the
current cells and the poplists
synchronized, make all changes between
the first and last row. Do not type in Rows
land 2.

Delete a Type

Delete the row from the list of defined
values (choose Edit> Delete Row).

Create a default Type

Enter a value in Column A2. Self-Service
Time displays the contents of Column A2
by default in the Type field. If you leave
Column A2 empty, the default value in the
poplists will be blank.

Alphabetize the Types in the poplists

Choose Sort from the Data menu.

Table 1-5 Types Worksheet

Note: Type the System Linkage Code and Expenditure Type that
you use in Column B and C exactly as they were entered in
Self-Service Time. Otherwise, the system displays errors when
uploading the spreadsheet. Look up all working values of System
Linkage Code and Expenditure Type in the Expenditure_Type and
System_Linkage Function columns in the view
PA_ONLINE_EXPENDITURE_TYPES_V. Make sure they are
active by looking at the values stored in the following columns:

e Sys_Link_Start Date_Active
e Sys_Link_End_Date_Active

* Expnd_Typ_Start Date_Active

e Expnd_Typ End_Date Active (To set a default value for this
field, enter the value in row 2.)

2. Test your changes by selecting the Timecard worksheet and
reviewing the options in the Type field.

Change the Week Ending Day

1-18

You selected the week ending day in the section: Setting the Week
Ending Day: page 1-15. Define the week ending day in your

spreadsheet to use the same day.

p Tochange the week ending day:

1. Select the Other Setup worksheet tab.
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Create Cell Links

2. Enter a number between 1 and 7 in cell B1. Each number
represents a day of the week (for example, enter 4 if you want the
Week Ending day to be Wednesday):

1 - Sunday

2 — Monday

3 — Tuesday

4 — Wednesday
5 - Thursday
6 — Friday

7 — Saturday

3. Select the Timecard worksheet to see the effect of your change. The
week ending day always appears last in the spreadsheet.

Note: If a user enters a date in the Week Ending field that is at
the end of the week, then all seven dates for the week appear
above the days. Otherwise, no dates are displayed.

4. (Optional) If users never work on particular days (Saturday and
Sunday, for example), remove those columns from the Timecard
worksheet.

Cell links determine the default value shown in a poplists. You
probably do not need to modify this worksheet unless you want to set a
default for the Type field or if you are setting up descriptive flexfields.

» To create cell links:

1. Select the Cell Links worksheet tab.

2. The default for the Type field in the Timecard worksheet is set in
Column A. Modify the values as needed:

A value of 1 indicates a blank value (default shipped in product).
A value of 2 indicates the first set of values defined in the Types
worksheet, a value of 3 for the second set of values defined in the
Types worksheet, and so on.

The value stored in cell A2 affects the Type in Line 1 of the
Timecard worksheet, A4 affects Line 2, A6 affects Line 3, and so on.

Changes are reflected immediately in the Timecard worksheet.
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Change Prompts

You can change many of the prompt names shown in the Timecard
worksheet.

» Tochange the prompt names:
1. Select the Prompts worksheet tab.
2. Change the values in Column B.

Important: If you change any prompts on the spreadsheet,
query PA_WEB_TIME_SPREADSHEET in the Region Items
window in Oracle Web Applications Dictionary and change the
corresponding Long Label (Prompt). If you do not change the
long label, the system does not recognize the spreadsheet
prompt and ignores any value you enter for it.

For more information on customizing the Long Label (Prompt),
see: Using Web Application Dictionary to Create Reports: page
2-3 or: Associating Attributes with Regions in the Oracle Web
Applications Dictionary User’s Guide.

Set Up Global Descriptive Flexfields

You cannot include context-sensitive descriptive flexfields in the
spreadsheet. However, you can add descriptive flexfields to the
spreadsheet as long as they are global (that is, they affect all hours
entered, regardless of their Type).

p Toset up global descriptive flexfields:
1. Define the flexfields in Oracle Applications: page 1-11.
2. Enter the window prompts for the segments: page 1-21.
3. Enter text flexfields: page 1-21.
4. Copy and paste the check box and poplist examples: page 1-21.
5

Determine the location of cell links for check boxes and poplists:
page 1-22.

6. Complete the setup for check boxes: page 1-22.
7. Complete the setup for poplists: page 1-23.

Before you define flexfields in the spreadsheet, you must define them
in Oracle Applications.
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» To define the flexfields:

1. In Oracle Applications, open the Segments Summary dialog
window (Application > Flexfield > Description > Segments >
Segment button) from the Global Data Elements descriptive
flexfield setup.

2. Note the window prompts for all global flexfields you are using
(they are case sensitive) as well as the order in which they were
defined.

3. Select the Timecard Flexfield Example worksheet tab. This
worksheet shows an example of global flexfields for a text box
(Example 1), check box (Example 2), and poplist (Example 3).

This worksheet is for your information only and is not a functional
area of the spreadsheet. To modify flexfield definitions, open the
Timecard worksheet tab.

Enter the window prompts for the segments

About text flexfields: Once you define the flexfields in Oracle
Applications and enter the window prompts for the segments, no
further action is required to set up text flexfields. Users enter data
directly into the spreadsheet cell and formulas are unnecessary.

» Toenter window prompts:

1. Select the Timecard worksheet tab.

2. After each row containing Comments in the Line Type column, add
a row for each global flexfield segment.

3. Inthe Line Type column, enter the window prompts of the
segments in the order in which they were defined in Oracle
Applications. Repeat this step for each row that you added to the
spreadsheet in step 2.

Copy and paste the check box and poplist examples

Do this step only for check box and poplist flexfields.

» To copy examples:

1. Open the Timecard Flexfield Example worksheet. Be sure that the
worksheet is “unprotected” (Tools>Protection>Unprotect Sheet),
then copy the example check box and poplist objects.
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2. Select the Timecard worksheet tab, and then paste the example into
each day column (Sunday through Saturday) for each row that you
added in step 2 of the section above (the global flexfield segments).

Determine the location of cell links for check boxes and poplists

The state of each check box and poplist is stored in a cell in the Cell
Links worksheet. To determine the column and row, the spreadsheet
uses the following mapping:

e The column is equal to column...
— B if the checkbox or poplist object corresponds to Sunday;,
— Cif the checkbox or poplist object corresponds to Monday;,

— and so on through column H, which corresponds to
Saturday.

Note: This information assumes that you specified a week
ending day of 7, or Saturday. See: Change the Week Ending
Day: page 1-18.
» For rows, use the spreadsheet row in which the check box or
poplist appears.

Note: When setting up descriptive flexfields in the Cell Links
worksheet, be careful not to overwrite any existing values in
Column A or allow the cell links of one descriptive flexfield to
interfere with another.

Complete the setup for check boxes

p To complete the setup for check boxes:

1. Right click on the check box cell.
2. Select Format Object.
3. Enter your cell reference in the Cell Link field in the Control tab.

Example: ’Cell Lines IB3. Replace B3 with the row column from the
previous step (see: Determine the location of cell links for check
boxes and poplists: page 1-22).

4. Enter the check box formula in the cell containing the check box.

Example: The formula IF('Cell Links’!B3=TRUE,”Y”,”N”") returns Y
(Yes) for selected check boxes and N (No) for unselected check
boxes. The formula returns Y if the check box that references cell
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B3 in the Cell Links worksheet is selected. Replace B3 with the
value specified in the Cell Link field in the Control tab.

Complete the poplists setup

To complete the poplists setup:

1.

Verify that you have pasted the example poplist into the Timecard
worksheet. See: Copy and paste the check box and poplist
examples: page 1-21.

Select the Types worksheet.

Starting in Column E, you can define your own options for the list
of values. Modify the values (they are case sensitive) to match
what you defined in the corresponding value set used for Oracle
Applications.

The name of your descriptive flexfield segment and poplist values
must match those created in the application. See: Setting Up
Descriptive Flexfields: page 1-11.

Select the Timecard worksheet tab, then select one of the poplists
you just created.

Click your right mouse button on the newly—created poplists, then
choose Format Object.

Select the Control tab and format the Input Range field. The value
in the field creates the formula associated with the poplists.

The Input Range field controls where the values for the poplists are
stored. For example, "Types!$E$2:$E$6” indicates that the poplist
values are located from cell E2 to cell E6 in the Types worksheet.

Select the Control tab and format the Cell Link field. As with the
Input Range field, the value in the field creates the formula
associated with the poplists.

The Cell Link field holds the value associated with the selected
item from the poplists. For example, ”Cell Links’!$B$2”” means that
the cell values will be stored in cell B2 in the Cell Links worksheet.
Replace B2 with the row column calculated when you determined
the location of the cell links. See: Determine the location of cell
links for check boxes and poplists: page 1-22.

Repeat steps 5-7 for each new poplist, then save your work.
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Check Your Work and Protect the Spreadsheet

1-24

When your changes are complete, protect the spreadsheet from changes
and do a final check of your work.

p To test your customizations and protect the spreadsheet:

1.

Protect the Timecard worksheet by choosing Tools > Protection >
Protect Sheet.

Verify that the Timecard worksheet (including the Type poplists
and any descriptive flexfields) works properly.

Hide all worksheet tabs: choose Tools> Options, choose the View
tab, then deselect the Sheet Tabs check box.

Click in the first cell a user would usually select, such as the Week
Ending field.

Protect your changes: choose Tools> Protection> Protect Sheet.
Save the spreadsheet.

Store the spreadsheet on the web server in the virtual directory
OA_HTML/US. This makes the spreadsheet available for
download from the Self-Service Time main menu.
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Self-Service Time Interface to Oracle Projects

Importing Transactions

>

Self-Service Time uses the Transaction Import open interface to
integrate with Oracle Projects. You can use the Batch Name
Determination Extension to group timecards for Transaction Import
into Projects. You can also customize this extension to meet your
needs.

By default, timecards are grouped by week ending date and employee
organization. See: Using Client Extensions Customize Self-Service
Time: page 2-12.

To import the approved timecards from Self-Service Time into
Oracle Projects:

1. Using the Projects responsibility, navigate to the Submit Request
window.

2. Run the PRC: Transaction Import process, using a Transaction
Source of Self-Service Time.

You can import all the batches at the same time, or select a batch
from the list of values in the Batch field.

3. Click Submit Request.

Importing Negative Transactions from Self-Service Time

The Matched Status Override Extension controls whether the status of
negative transactions is ”matched” or “unmatched.” See: Matched
Status Override Extension: page 2-18.

If the status of the negative transaction is matched (the default setting),
transaction import tries to match the transaction with a positive
transaction of the same expenditure item date, project, task and
expenditure type. If a match isn’t found, the transaction is rejected.

Importing Rejected Unmatched Transactions

You can view the rejected transactions in the Review Transaction
window and change the Unmatched Negative Transaction attribute of
the rejected transaction from No to Yes. Then, run Transaction Import
again to import the previously rejected transactions into Projects.
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p To import rejected unmatched transactions:

1.

Using the Projects responsibility, navigate to the Review
Transactions window.

Enter Self-Service Time in the Transaction Source field, and the
batch name in the Batch field (Optional).

Choose Transaction Status Import-Rejected, then click the Find
button.

Find the rejected transaction. The system displays a rejection
reason of No Matching Item.

Navigate to the Unmatched Negative Transaction field (you may
need to use the folder tools to do this). Change the value of the
flag from No to Yes.

Choose the Import button.

In the Review Transaction window, query your transaction to
verify that it was imported successfully.

Adjusting Transactions Imported from Self-Service Time

1-26

In Oracle Projects you can adjust transactions imported from
Self-Service Time. However, the adjustments are not visible in
Self-Service Time. Additionally, transactions adjusted in Self-Service
Time (using matched negative transactions) cannot be adjusted in
Oracle Projects.
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Migrating Data from ProjTE and PTE to Self-Service Time

All timecards in your existing application—either Personal Time and
Expense (PTE) or Project Time and Expense (ProjTE)—must be
submitted and approved before they are eligible to be migrated to
Self-Service Time.

During the migration to Self-Service Time, the system prompts you to
specify the historical data to migrate. All of the selected online
timecards (created from PTE or ProjTE) are upgraded to Self-Service
Time. After migration, these timecards are visible from the Self-Service
Time application as historical records.

Parameters

The migration script contains parameters you can use to select the
transactions to migrate from ProjTE/PTE to Self-Service Time. The
parameters include:

e Operating Unit ID (organization_id of the operating unit)
¢ Incurred by Person Number (employee number)

¢ Incurred by Organization Name (expenditure organization
name)

» pte_ote_or_both (1=PTE only; 2=ProjTE only; 3=both)
 Starting Expenditure Ending Date
* Ending Expenditure Ending Date
The following parameters are required:
e Operating Unit ID (for multiple organization installations)
e Incurred by Person Number or Incurred by Organization Name

All other parameters must contain a value or be NULL.

» To migrate timecard data to Self-Service Time:
1. Log on to your server.
2. Change your directory to:

e $PA_TOP/patch/115/sql (See: Notes on Terminology and File
Locations: page 1-2.)

3. Run the following migration script:

$ sqglplus <apps username>/<apps password> @paxtmsst.sql
<operating unit id> <incurred by person number> <incurred by
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organization name> <1=PTE only; 2=ProjTE only; 3=both>
<starting expenditure ending date> <ending expenditure date>

Example: The following command migrates PTE timecards for the
Operating Unit ID 458, incurred by Person Number 205, for week
ending dates from 28-DEC-1997 through 15-FEB-1998, inclusive:

sqlplus <apps username>/<apps password>@paxtmsst.sql 458 205
NULL 1 '28-DEC-1997’ '15-FEB-1998’
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Customizing
Self-Service Time

CHAPTER

T his chapter describes how to customize your Self-Service Time
implementation. It explains how you can modify the appearance and
content of application pages, control access to data, and use client
extensions to enforce business rules that are specific to your
organization.
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Customizing Self-Service Time

You can customize Self-Service Time by:
« Controlling Access to Self-Service Time data: page 2-2

e Using the Web Applications Dictionary to modify screen content;
page 2-3

* Modifying messages: page 2—6
» Using Client Exensions: page 2-12

Controlling Access to Self-Service Time

You can configure Self-Service Time poplists for projects, tasks,
expenditure types, and overriding approvers to meet your
requirements. To do this, modify the WHERE clause in the
corresponding view listed in this section.

The views control the project and task values that users can download
from the View Projects and Tasks link on the Self-Service Time main
menu.

Views are associated with the timecard preparer (that is, the person
logged into the system). Because these views are used for validation
and display, be sure to set up the the view so that the timecard preparer
can select the projects for which he is entering hours.

You can customize the following views:

View and Filename of Scripts* and Notes
Internal Name

Project View pavw681.sql *
PA_ONLINE_PROJECTS_V Default allows user to view all projects.

Sample code specifies that projects selected
must be within the user’s organization.

Do not modify the base view
PA_PROJECTS_EXPEND_V.

Task View pavwe82.sql *
PA_ONLINE_TASKS V Default allows user to view all tasks.

Sample code specifies that tasks selected
must be within the user’s organization.

Do not modify the base view
PA_TASKS_EXPEND_V.

Table 2 -1 Views that you can customize (Page 1 of 2)
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View and Filename of Scripts* and Notes
Internal Name

Expenditure Type View pavw742.sql *
PA_ONLINE_EXPENDITURE_TYPES_V | Default allows user to view all expenditure
types.

Sample code specifies that users in the
Consulting organization
(organization_id=1) can enter only
transactions of type Straight Time.

Do not modify the base view
PA_ONLINE_EXPENDITURE_TYPES_V.

Overriding Approver View pavwe85.sqgl *

PA_EXP_OVRRDE_APPROVER_V Default allows user to view all supervisors
in the preparer’s business group.

Sample code specifies that users can only
select overriding approvers who belong to
the user’s organization.

Table 2 -1 Views that you can customize (Page 2 of 2)

* Scripts are located in the $PA_TOP/patch/115/sql directory. See: Notes on
Terminology and File Locations: page 1-2.

Using Web Application Dictionary to Modify Self-Service Time

The Web Applications Dictionary is an Oracle Applications module you
can use to configure the content of Self-Service Time web pages. For
example, you can change the names of fields and buttons to
terminology that is specific to your organization or add text to pages
that require additional information.

Changing the Prompt Example

The following table lists regions in Web Application Dictionary that
you can use to modify field names in Self-Service Time. The field
prompt names are displayed using functions of the Timecards
responsibility.

Region ID Description

PA_WEB_BUTTON Bottom region of the timecard entry screens
and user preferences

PA_WEB_CALENDAR Calendar window

PA_WEB_CONFIRMATION Final Review, Save confirmation, and Submit
confirmation page; Timecard detail page;
workflow notification

Table 2 -2 Regions in Web Application Dictionary
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Region ID

Description

PA_WEB_DETAIL

Enter Hours Detail window

PA_WEB_ERRORS

Timecard error window

PA_WEB_TIME_ENTRY

Time Entry page

PA_WEB_TIME_SPREADSHEET

Disconnected spreadsheet

PA_WEB_TIME_UPLOAD

Upload spreadsheet page

PA_WEB_TOOL_BAR

Top region of the timecard entry screens and
user preferences

PA_WEB_USER_PREFERENCE_BODY

User preferences page

PA_WEB_APPR_LOV

Overriding Approver LOV

PA_WEB_PROJECTS_LOV

Projects LOV

PA_WEB_PROJECTS_TASKS_LOV

Tasks LOV and View Projects and Tasks
inquiry

PA_WEB_MODIFY_TIMECARD

Modify Timecard inquiry

PA_WEB_TIMECARD_HISTORY

Timecard History inquiry

PA_WEB_UPLOAD_SUMMARY

Upload Summary page

Table 2-2 Regions in Web Application Dictionary

To change the prompt name:

1. Using the AK Developer Responsibility, navigate to the Regions

window.

2. Inthe Region ID field, query the region you want to modify. For
example, to change a prompt name on the Enter Hours page, query

PA_WEB_LINES_BODY.

3. Choose Region Items.

4. Scroll to the Long Label column you want to change, and then
change the long label. For example, to change a prompt on the
Time Entry page, query PA_WEB_TIME_ENTRY.

5. Save your work.

Note: If you update a prompt on one page, be sure to update it
on any other pages that use the same prompt.

Changing Display Length in the Enter Hours and User Preferences

Windows

You can customize the display length for the attributes in the Enter
Hours and User Preference windows. For example, you may want to
increase the display length if the values in the lists for the Type field are

truncated.
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To modify the display length in the Enter Hours or User Preferences

window:
1. Using the AK Developer Responsibility, navigate to the Regions
window.
2. Inthe Region ID field, query a region:
* PA_WEB_TIME_ENTRY to make changes in the Enter Hours
window
« PA_WEB USER_PREFERENCE_BODY to make changes in the
User Preferences window
3. Choose Region Items.
4. Scroll to the Display length column next to PA_WEB_EXP_TYPE,

and then change the length.

For example, if you enter 20, the width of the Type field in the
window changes to 20 characters.

Changing Widget Size

You can change the size of widgets in the User Preferences, and Time

Entry Windows.

Region ID and Description Region Items

PA_WEB_USER_PREFERENCE_BODY |PA_WEB_HEADER_COMMENT

Preferences region PA_WEB_OVERRIDING_APPROVER
PA_WEB_PROJECT_NUMBER
PA_WEB_TASK_NUMBER
PA_WEB_EXP_BODY

PA_WEB_TIME_ENTRY PA_WEB_HEADER_COMMENT

Time Entry window PA_WEB_OVERRIDING_APPROVER
PA_WEB_PROJECT_NUMBER
PA_WEB_TASK_NUMBER
PA_WEB_EXP_TYPE
PA_WEB_HOURS

Table 2 -3 Regions in Web Application Dictionary for Widgits
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Customizing Self-Service Time Messages

You can modify the content of any Self-Service Time message using the
Application Developer Responsibility in Oracle Applications.
Messages include the information that appears in Self-Service Time
windows as well as the messages that display in pop-up windows if an
error occurs when creating or submitting timecards.

For information about editing messages, see Messages in the online
help for Oracle Applications Object Library. For more information
about the Message Dictionary Generator, see Oracle Applications Coding
Standards.

Copy all your custom messages and store them in a directory protected
from upgrades. Then use the Message Dictionary Generator
(FNDMDGEN) to restore the customized message file.

Client Messages are stored in
$PA_TOP/patch/115/import/patl15mg.ldt. To modify server-side
messages, use the Oracle Applications Messages window. See: Notes
on Terminology and File Locations: page 1-2.

To customize messages:

1. Using the Application Developer Responsibility, navigate to the
Messages window.

2. Inthe Name field, query the message to modify.

"PA_WEB%”.

3. Make any changes to the message text, then save your work.

@ Suggestion: To view all Self-Service Time messages, query

The client messages are shown in Table 2 — 4.

Message Name and When the Message Appears Default Text

PA_WEB_APPLY_DETAIL Do you want to apply the

R . R i i ?
Whenever the user changes information on the detail | changes to the Details window

page and the user exits without saving.

PA_WEB_BLANK_TYPE The expenditure type is no
longer valid for this week. The

When the user tries to apply an alias with an expired value has been blanked out.

expenditure type.

PA_WEB_CONFIRM_SAVE Confirm that you want to save
Whenever the user chooses Save Timecard. %?;;ttémecard. (You can modify
PA_WEB_CONFIRM_SUBMIT Are you sure you want to

. it this ti ?
Whenever the user chooses Submit. submit this timecard

Table 2 -4 Client Messages (Page 1 of 6)
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Message Name and When the Message Appears

Default Text

PA_WEB_DELETE_REMIND_RELOAD
When the user deletes a timecard.

To see your changes, wait until
the browser displays the Modify
Timecard page. Then click the
Reload or Refresh button on
your browser.

PA_WEB_DFLEX_REQUIRED

When the user has not entered a value in one or more
descriptive flexfields.

[SEGMENT] is a required field.
Enter a value for this field.

PA_WEB_DISC_DATA_ERROR

When user enters non—-numeric hours in the
spreadsheet.

You have entered a non numeric
value for hours.

PA_WEB_DISC_ZERO_PROMPTS_FOUND
Incorrect setup in a spreadsheet region.

The region is set up incorrectly.
Please contact your system
administrator.

PA_WEB_DUPLICATE_PROMPT
Duplicate prompt in the spreadsheet.

The spreadsheet contains
multiple prompts for
'[PROMPT]’. The system wiill
use the first value it encounters.

PA_WEB_ENTER_HOURS

When the user places the insertion point in an empty
hour cell and then selects the Details button.

Please enter hours for the hour
cell before opening the detail
window.

PA_WEB_ERASE_HOUR

When the user changes the week ending date after
entering hours in the Enter Hours tab.

Changing the Week Ending date
will erase all the hours you have
entered. Are you sure you want
to continue?

PA_WEB_ERROR_CORRECTION
Instruction at the top of the Error Page.

Please correct the following
information before you proceed.

PA_WEB_EXIT_TIMECARD

When the user clicks on the Menu or Exit button
(sphere icon) from any page.

This action will close the current
timecard without saving. Are
you sure you want to continue?

PA_WEB_FINAL_REVIEW_HEADING
Heading on Final Review Page.

Your timecard contains the
following information:

PA_WEB_GO_BACK
Return to previous page.

Return to Previous Page

PA_WEB_HOUR_ON_WORKDAY
Workdays should be changed to view all hours.

A day containing hours is not
marked as a work day. Go to the
User Preferences (click
Preferences on the Enter Hours
window), or click the Menu
button to go to the main menu
and then choose User
Preferences) and adjust your
work days.

PA_WEB_INVALID_DATE_RANGE

When the user enters hours for a date that is inactive
for the Expenditure Type.

The date for which you are
entering hours is out of the
range of dates for that
expenditure type.

Table 2 -4 Client Messages (Page 2 of 6)
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2-8

Message Name and When the Message Appears

Default Text

PA_WEB_MISSING_PROMPT
Required prompt is missing from spreadsheet.

'[PROMPT]’ prompt is missing
from the spreadsheet. Please
contact your system
administrator.

PA_WEB_NOTHING_TO_COPY
When the user tries to copy from an empty line.

There is nothing to copy.

PA_WEB_NOT_LICENSED
Message displayed for unlicensed product.

The system profile option setup
indicates that your system is not
licensed to run Self-Service
Time. Please contact your
system administrator and verify
the profile option settings.

PA_WEB_NO_ALIAS

When the user selects the Apply Alias button but
there is no selection in the select box.

You have not defined an alias.

PA_WEB_NO_HOUR

When the user selects the Final Review button
without entering at least one line of hours.

You have not entered any hours
for this week.

PA_WEB_NO_PROJECT

During client side validation, display this message for
all the Projects that are missing.

Project is missing.

PA_WEB_NO_TASK

During client side validation, display this message for
all the Tasks that are missing.

Task is missing.

PA_WEB_NUM_FORMAT

When the user enters a character or other invalid
formats in the hours field.

The hours must be in number
format.

PA_WEB_OAPPROVER_NOT_ALLOWED
PA: Override Approver profile option is set to No.

Your system does not allow an
overriding approver. Your input
will be ignored.

PA_WEB_POS_NUM

When the user enters a negative number and negative
number input is not allowed.

[Number] is negative. Please
enter a positive number.

PA_WEB_PROJECT_TASK_INVALID

User chooses the Save button but one or more project
or task are blank or invalid.

You must enter valid values for
the Project and Task fields for
each alias.

PA_WEB_REVERSE_OBSOLETE

User modifies a timecard after some lines have
already been reversed in a different timecard..

Some lines on this timecard
were reversed previously. These
lines will be deleted when you
save or submit.

PA_WEB_SAVE_CONF_HEADING
Heading on Save Confirmation Page.

Timecard Number
[TCNUMBER] has been saved.

Table 2 -4 Client Messages (Page 3 of 6)
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Message Name and When the Message Appears

Default Text

PA_WEB_SAVE_CONF_INSTRUCTION
Instructions to retrieve saved timecards.

You cannot submit saved
timecards for approval. Use the
Modify Timecard function from
the main menu (Welcome
window) to continue with the
submission process.

PA_WEB_SUBMIT_CONF_HEADING
Heading on Submit Confirmation Page.

Timecard Number
[TCNUMBER] has been
submitted.

PA_WEB_SUBMIT_CONF_INSTRUCTION
Instructions on Submit confirmation page.

PA_WEB_TASK_LOV_NO_PROJECT

Prompt user to enter a project number before clicking
task LOV.

Please select a project before you
select a task.

PA_WEB_UPLOAD_SUMMARY_HEADER
Heading on the Upload Summary Page.

Upload Results

PA_WEB_UPLOAD_CANCEL_TIMECARD
Alert when the user presses the Cancel button.

Are you sure you want to cancel
this timecard?

PA_WEB_UPLOAD_EMPTY_TIMECARD
The paste area is empty.

This is not a valid action. Please
paste your timecard spreadsheet
in the Spreadsheet Upload Area.

PA_WEB_UPLOAD_FORMAT_ERRORS

Format or setup errors found in the Spreadsheet
during parsing.

The following format errors
were found:

PA_WEB_UPLOAD_FORMAT_WARNINGS

Format or setup warnings found in the Spreadsheet
during parsing.

The following format warnings
were found:

PA_WEB_UPLOAD HEADER
Heading on the Upload Timecard Page.

Upload Timecard

Table 2-4 Client Messages (Page 4 of 6)
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Message Name and When the Message Appears

Default Text

PA_WEB_UPLOAD_INSTRUCTIONS
Instructions on Upload Timecard Page.

Instructions

Download the timecard
spreadsheet. Save a copy to
serve as a template for the
timecard that you will submit.
Open the timecard spreadsheet
and track your time in the
spreadsheet. Do not enter text
in the colored or shaded areas of
the spreadsheet. Save the
timecard spreadsheet. Highlight
the entire report Copy the report
(Ctrl-C or choose Edit-Copy
from the spreadsheet menu).
Click inside the Spreadsheet
Upload Area and then paste
your timecard (Ctrl-V or choose
Edit-Paste from the spreadsheet
menu). Click the Validate
button.

PA_WEB_UPLOAD_SUMMARY_ERROR

Message on Upload Summary Page if validation
found errors in timecard.

The timecard processed
[NUM_ERRORS] line(s) with
errors. Please click the Continue
button to proceed.

PA_WEB_UPLOAD_SUMMARY_HEADER
Header on Upload Summary Page.

Upload Results

PA_WEB_UPLOAD_SUMMARY_SUCCESS

Message on Upload Summary Page if validation
succeeded without any errors.

Timecard processed 0 line(s)
with errors. Please click the
Final Review button to review
the timecard.

PA_WEB_UPLOAD_SUMMARY_TITLE
Title on Upload Summary Page.

Upload Results

PA_WEB_UPLOAD TITLE
Title on Upload Timecard Page.

Upload Timecard

PA_WEB_USER_PREF_ALIAS_DUP
Duplicate alias names exist.

Alias names must be unique.

PA_WEB_USER_PREF_ALIAS_MISSING
Alias name missing in a line.

The alias name is missing in this
line.

PA_WEB_USER_PREF_CANCEL

User chose the Cancel button in the User Preferences
window.

Do you want to abandon your
changes to User Preferences?

PA_WEB_USER_PREF_HEADER_CHANGE

User chooses Save button in User Preferences window
after making changes to the header.

The changes you have made will
be effective the next time you
create a new timecard.

PA_WEB_USER_PREF_NO_WORKDAY
Prompt user to check at least one working day.

Please select at least one
working day.

Table 2 -4 Client Messages (Page 5 of 6)
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Message Name and When the Message Appears

Default Text

PA_WEB_VERIFY_DELETE

Confirm whether the user wants to delete the
timecard.

Are you sure you want to delete
this timecard?

PA_WEB_VIEW_ONLY_HEADING
Heading on View Only page.

Timecard Details

PA_WEB_WEEK_ENDING_INVALID_FMT
Format of week ending date in spreadsheet is invalid.

Incorrect Week Ending date:
Format not valid.

PA_WEB_WEEK_ENDING_MISMATCH

Week ending date in spreadsheet does not correspond
to system week ending date.

The week ending date in the
spreadsheet is not the same as
the system week ending date.

PA_WEB_WEEK_ENDING_NULL
Week ending date not supplied in the spreadsheet.

Please enter or correct the week
ending date.

PA_WEB_WRONG_FIELD

The user is trying to open the Detail window, but the
cursor is not at the hour cell.

Please place the text insertion
point in the hour cell before you
click the Details button.

Table 2 -4 Client Messages (Page 6 of 6)
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Using Client Extensions to Customize Self-Service Time

2-12

You can modify the following client extensions to route and approve
timecards according to your requirements and to enforce any custom
business rules. Client extensions use PL/SQL procedures that Oracle
Projects periodically uses when processing timecards. For more
information, see: Client Extensions in the Oracle Projects User Guide.

You can use the following client extensions with Self-Service Time:

Extension and Reference

Package Body and
Package Specification
Files

Package and Procedure

Approval: page 2-16

PAXTRT1B.pls
PAXTRT1S.pls

PA_CLIENT_EXTN_RTE
check_approval

AutoApproval: page 2-13

PAXPTEEB.pls
PAXPTEES.pls

PA_CLIENT_EXTN_PTE
get_exp_autoapproval

Batch Name Determination:
page 2-19

PAPSSTCB.pls
PAPSSTCS.pls

PA_TIME_CLIENT_EXTN
set_batch_name

Business Message Display:
page 2-22

PAPSSTCB.pls
PAPSSTCS.pls

PA_TIME_CLIENT_EXTN
display_business_message

Custom Default Descriptive
Flex Value*: page 2-26

PAPSSDFB.pls
PAPSSDFS.pls

PA_CLIENT_EXTN_SST_DFF
POPULATEDFLEXDEFAULT

Custom Populate
Descriptive Flex Poplist*:
page 2-24

PAPSSDFB pls
PAPSSDFS.pls

PA_CLIENT_EXTN_SST_DFF
POPULATEFLEXPOPLIST

Matched Status Override:
page 2-18

PAPSSTCB.pls
PAPSSTCS.pls

PA_TIME_CLIENT_EXTN
override_match_status

page 2-14

PAXTGTCS.pls

Routing: page 2-15 PAXTRTEB.pls PAROUTINGX
PAXTRTES.pls route_to_extension
Summary Level Validation: | PAXTGTCB.pls PAGTCX

summary_validation_extension

Transaction Control: page
2-13

PAXTTCXB.pls
PAXTTCXS.pls

PATCX
tc_extension

*A poplist displays a list of values

Table 2 -5 Client Extensions Used with Self-Service Time
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Custom Populate
Descriptive Flex Poplist

Custom Default
Descriptive Flex Poplist

The client extensions are called during the following processes:

Final Revi
Transaction Control
Summaty Level Validation

Submit
All Final Review*
Matched Status Override

Approv%

— N\ )
Business Message Display || Validated > AutoApproval Transaction Import
Routing
Approval

Batch Name Determination

*When the user submits the timecard, the system repeats the Final Review client extensions and validations

Location of Client Extension Files

Print and review the files before modifying an extension. The files are
located in the following Oracle Projects directory:

$PA_TOP/patch/115/sq|

See: Notes on Terminology and File Locations: page 1-2.

Oracle Projects Client Extensions

The following client extensions are used by Self-Service Time but are
documented elsewhere.

AutoApproval Extension

The default for this extension returns the value of the profile option PA:
AutoApprove Timecard. You can configure this extension to meet your
needs. For example, you may want timecards to be approved
automatically unless they contain overtime. Those with overtime must
be routed to the employee’s supervisor.

For more information, see the Oracle Projects User’s Guide.

Transaction Control Extension

Timecard line level validation via Transaction Control extensions allow
you to define your own rules to implement company-specific time
entry policies for individual time entries.

For more information, see the Oracle Projects User’s Guide.
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Summary-Level Validation Extension

Use the summary-level validation extension to check the validity of

one or more items in

a submitted expenditure. For example, you could

automatically reject any timecard that contains more (or less) than 40

hours.

The extension includes the following items:

Item

Name

Body template

PAXTGTCB.pls

Specification template

PAXTGTCS.pls

Package

PAGTCX

Procedure

summary_validation_extension

Table 2 -6 Summary-Level Validation Extension

Print and review the

files before writing the extension. See: Location of

Client Extension Files: page 2-13.

Summary Validation Procedure

The extension uses the following parameters:

Parameter Usage Type Description

X_expenditure_id IN NUMBER Identifies the expenditure.

X_incurred_by_person_id |IN NUMBER Identifies the employee that
submitted the expenditure.

X_expenditure_end_date IN DATE Ending date of the
expenditure period.

X_exp_class_code IN VARCHAR?2 Identifies the expenditure
class (OT for timecards).

X status ouT VARCHAR?2 Denotes the status of the

B expenditure (APPROVED or

REJECTED). See: About the
status Parameter: page 2-15.

X_comment ouT VARCHAR?2 Comment to be passed back

to the employee who
submitted the expenditure.
Stored as an expenditure
routing comment.

Table 2 -7 Parameters for the Summary-Level Validation Extension
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About the status parameter

Use the status parameter (X_status) to handle error conditions for your
procedure. This parameter indicates the processing status of your
extension:

x_status =0 The extension executed successfully.
X_status <0 An Oracle8 error occurred.
X_status >0 An application error occurred. Your extension

must return an error message code.

Routing Extension

Route To Procedure

Use the routing extension to set the business rules for routing timecards
for approval. For example, timecards that contain overtime could be
routed to the project manager of the charged project. By default, this
extension returns the immediate supervisor of the employee who
created the timecard.

The extension includes the following items:

Item Name

Body template PAXTRTEB.pls

Specification template | PAXTRTES.pls

Package PAROUTINGX

Procedure route_to_extension

Table 2-8 Routing Extension

Print and review the files before writing the extension. See: Location of
Client Extension Files: page 2-13.

The extension uses the following parameters:

Parameter Usage | Type Description

X_expenditure_id IN NUMBER System-generated identifier
of the expenditure

X_incurred_by_person_id IN NUMBER Identifies the employee who
performed the work

Table 2 -9 Parameters for the Routing Extension
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Parameter Usage | Type Description

X_expenditure_end_date IN DATE Ending date of the
expenditure week

X_exp_class_code IN VARCHAR?2 Identifies the expenditure
type (OT for timecards)

X_previous_approver_ IN NUMBER Employee to whom the

person_id timecard was previously
routed

X_route_to_person_id ouT NUMBER Identifies the employee to
whom expenditure is to be
routed

Table 2 -9 Parameters for the Routing Extension

Approval Extension

This extension determines if additional approval is required for the
timecard. By default, there is no restriction on approval.

The extension includes the following items:

Iltem Name

Body template PAXTRT1B.pls

Specification template | PAXTRT1S.pls

Package PA_CLIENT_EXTN_RTE

Procedure check_approval

Table 2 -10 Approval Extension

Print and review the files before writing the extension. See: Location of
Client Extension Files: page 2-13.

Check Approval Procedure

The extension uses the following parameters:

Parameter Usage | Type Description

X_expenditure_id IN NUMBER System-generated identifier
of the expenditure.

X_incurred_by_person_id IN NUMBER Identifies the employee who
performed the work.

Table 2 - 11 Parameters for the Approval Extension
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Parameter

Usage

Type

Description

X_expenditure_end_date

IN

DATE

Ending date of the
expenditure week.

X_exp_class_code

VARCHAR?2

Identifies the expenditure
type (OT for timecards).

X_amount

NUMBER

Amount of expenditure in
hours.

X_approver_id

NUMBER

Application user ID of
employee attempting to
approve the expenditure.

X_routed_to_mode

NUMBER

Responsibility of approving
employee (either
SUPERVISOR or ALL). See:
About the routed_to_mode
Parameter: page 2-17.

X_status

ouT

VARCHAR?2

Status of procedure. See:
About the status Parameter:
page 2-15.

X_application_id

ouT

NUMBER

Short name of application
defined in AOL. (PA for
Oracle Projects).

X_message_code

ouT

VARCHAR2

Message code.

X_token_1-5

ouT

VARCHAR?2

Message tokens passed back
to be used in message.

Table 2 - 11 Parameters for the Approval Extension

About the routed_to_mode Parameter

Depending on the navigation path, the routed_to_mode parameter
contains the value SUPERVISOR (Review and Approve) or ALL
(Review and Approve All).

You can use this parameter to allow the approver to circumvent the
rules enforced by the approval extension. For example, you might
want to use this parameter for a supervisor who needs to approve
hours regardless of any special logic in your extension.
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Matched Status Override Extension

You can set up this extension so that negative entries in Self-Service
Time are handled as either:

« Unmatched transactions (corresponding existing positive
transaction not required)

or

» Matched transactions (corresponding existing positive
transactions required)

The system calls the extension for all negative transactions. The default
setting marks as "matched” all negative values imported from
Self-Service Time. This means importing transactions into Projects
causes an error if the Transaction Import process cannot find a
matching transaction (for negative transactions that are matched).

You can customize this extension to change the default transaction
processing. For example, you may want all negative hours of a given
expenditure type imported from Self-Service Time to be Unmatched, as
they are used for summarizing negative entries.

The extension includes the following items:

Item Name

Body template PAPSSTCB.pls

Specification template | PAPSSTCS.pls

Package PA_TIME_CLIENT_EXTN

Procedure override_match_status

Table 2 -12 Matched Status Override Extension

Print and review the files before writing the extension. See: Location of
Client Extension Files: page 2-13.

Override Match Status Procedure

The procedure contains the default logic to mark as "matched” all
negative values imported from Self-Service Time.
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The extension uses the following parameters:

Parameter Usage Type Description

P_Person_lId IN NUMBER Employee_ID of the person
submitting the timecard.

P_Project_Id IN NUMBER Project Identifier for the item.

P_Task_Id IN NUMBER Task Identifier for the item.

P_Expenditure_Type |IN VARCHAR?2 | Expenditure Type of the item.

P_Expenditure_Type_ | IN VARCHAR?2 |Expenditure Type Class of the item.

Class

P_Expenditure_Item_ | IN DATE Date of the item.

Date

P_Quantity IN NUMBER Number of units for the transaction.

P_Expenditure_Com |IN VARCHAR?2 | Item level comment.

ment

P_Attribute_Category |IN VARCHAR?2 | Descriptive Flexfield context field.

P_Attributel-10 IN VARCHAR?2 | Descriptive Flexfield Segment

P_Match_Status IN VARCHAR2 |'U’

P_Match_Status IN VARCHAR?2 | Adjusted_denorm_id

X_Match_Status ouT VARCHAR?2 | Value of "M’ if the item is imported
as matched, and U’ if the item is
imported as an unmatched negative.

Table 2 - 13 Matched Staus Override Procedure Parameters (Page 1 of 1)

Batch Name Determination Extension

Use this extension to configure how the system batches timecards
before importing them into Oracle Projects. The default logic groups
timecards by week ending date and the employee’s expenditure
organization, but you can group timecards by a method that meets
your needs.

The batch name consists of the week ending date concatenated with a
number from 0-999. This number is associated with the expenditure
organization when the timecard is approved and remains the number
associated with that expenditure organization for that week ending
date. For the next week ending date, a different number is associated
with each organization.

You can configure the Batch Name Determination Extension to group
timecards based on any of the IN parameters listed in Table 2 - 16.

Note: Batch names cannot exceed 10 characters.
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Example

The first timecard to be approved with week ending date of 01-JAN-99
belongs to an employee in the Consulting expenditure organization.
The timecard batch name returned by the default client extension is
010199-0. If the next approved timecard for the same week ending
date belongs to a different organization, the timecard is assigned the
batch number 010199-1. Each new expenditure organization for a
particular week ending date is assigned a new batch name.

Each expenditure organization maintains the same batch name for a
particular week ending date. The concatenated numbers are assigned
in sequence until all 1000 numbers are assigned. Then, the
concatenated numbers are assigned starting again at 0. If you have
timecards approved for one week ending date that belong to more than
1000 expenditure organizations, you must modify the default Batch
Name Determination Extension.

Table 2 — 14 shows how the extension defaults assign batch names.

Week Ending Date | Expenditure Organization |Order * | Batch Name Associated
with the Timecard
01-JAN-1999 Consulting 1 010199-0
01-JAN-1999 Consulting—East 2 010199-1
01-JAN-1999 Consulting—West 3 010199-2
01-JAN-1999 Consulting 4 010199-0
08-JAN-1999 Consulting—East 1 010899-3
08-JAN-1999 Consulting—West 2 010899-4
08-JAN-1999 Consulting 3 010899-5
08-JAN-1999 Consulting 4 010899-5
08-JAN-1999 Consulting-East 5 010899-3

Table 2 - 14 Batch Name Defaults

The extension includes the following items:

Item Name

Body template PAPSSTCB.pls

Specification template | PAPSSTCS.pls

Package PA_TIME_CLIENT _EXTN

Procedure set_batch_name

Table 2 -15 Matched Status Override Extension

Print and review the files before writing the extension. See: Location of
Client Extension Files: page 2-13.
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Batch Name Determination Procedure

This procedure contains default logic that groups timecards by week
ending date and the employee’s expenditure organization.

The extension uses the following parameters:

Parameter

Usage

Type

Description

P_Expenditure_ld

IN

NUMBER

System-generated number that
uniquely identifies the expenditure.

P_Person_Iid

NUMBER

Identifier of the person entering
timecard information.

P_Expenditure_
Ending_Date

DATE

Period for which time is being
entered.

P_Expenditure_
Organization_Id

NUMBER

Identifier of the organization that
incurred the charges.

X_User_Batch_Name

VARCHAR?2

Ten character name for grouping
timecard. All timecards with same
batch name are imported into Oracle
Projects in the same expenditure
group if processed together.

X_Return_Status

ouT

VARCHAR?2

Indicates the status of the procedure.
Possible values are NULL (Success),
U’ (Unexpected Error), and 'E’
(Expected Error).

X_Application_Code

ouT

VARCHAR?2

Short name for application defined
in Oracle Application Object Library
(AOL). 'PA’ is defined for Oracle
Projects. You can define your own
custom application when defining
messages so they are retained
between upgrades.

X_Message_Code

ouT

VARCHAR?2

Message Code. Use this to pass error
messages to the calling program.
This is NULL for success. Handles
errors (return_status = 'E’) and is set
to the message code defined in AOL.
For unexpected error (return status =
'U’) itis set to the ORACLE error
code (SQLCODE). You may want to
pass tokens as part of your message.

X_Token_Namel

ouT

VARCHAR?2

Optional parameter provided to
construct the message. If this
parameter is used, the message text
should be constructed with token
name equal to the value in this
parameter.

X_Token_Vall

ouT

VARCHAR?2

Optional parameter provided to
construct the message. If this
parameter is used, the token used in
message text should be populated
with the value in this parameter.

X_Token_Name2

ouT

VARCHAR?2

Same as X_Token_Namel
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Parameter Usage Type Description
X_Token_Val2 ouT VARCHAR?2 |Same as X_Token_Vall
X_Token_Name3 ouT VARCHAR?2 | Same as X_Token_Namel
X_Token_Val3 ouT VARCHAR?2 | Same as X_Token_Vall
X_Token_Name4 ouT VARCHAR?2 | Same as X_Token_Namel
X_Token_Val4 ouT VARCHAR?2 | Same as X_Token_Vall
X_Token_Name5 ouT VARCHAR?2 | Same as X_Token_Namel
X_Token_Val5 ouT VARCHAR?2 | Same as X_Token_Vall

Table 2 -16 Batch Name Determination Procedure Parameters (Page 2 of 2)

Business Message Display Extension

The billable percentage is a calculation of the percentage of the hours in
a timecard that are marked as billable. This extension contains an
example that returns a message displaying the billable percentage for
the timecard (the example is preceded by the comment character). If
this example meets your requirements, remove the comment characters
from the example code after enabling the profile. This displays the

billable percentage message in Self-Service Time.

Note: The example code does not return a message. You must
set the profile option PA: Enable Business Message to Yes to see
your custom business message as defined in the Business

Message Display extension.

The extension includes the following items:

Item

Name

Body template

PAPSSTCB.pls

Specification template

PAPSSTCS.pls

Package

PA_TIME_CLIENT_EXTN

Procedure

display_business_message

Table 2 -17 Business Message Display Extension

Print and review the files before writing the extension. See: Location of

Client Extension Files: page 2-13.

Business Message Display Procedure

This package contains default logic to return a blank business message.
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The extension uses the following parameters:

Parameter Usage Type Description
P_Expenditure_ld IN NUMBER System-generated number that
uniquely identifies the expenditure.
P_Person_Id IN NUMBER Identifier of the person entering
timecard information.
P_Week_Ending_Date | IN DATE Period for which time is being
entered.
X_Message ouT VARCHAR?2 | Short name of the application that
Application_Name ”owns” the message.
X_Msg_Name ouT VARCHAR?2 | Message hame
X_Msg_Tokenl_Name | OUT VARCHAR?2 | Name for Tokenl
X_Msg_Tokenl_Value | OUT VARCHAR?2 | Token for message
X_Msg_Token2_Name | OUT VARCHAR?2 | Name for Token2
X_Msg_Token2_Value | OUT VARCHAR?2 | Token for message
X_Msg_Token3_Name | OUT VARCHAR2 | Name for Token3
X_Msg_Token3_Value | OUT VARCHAR?2 | Token for message
X_Return_Status ouT VARCHAR?2 | Indicates the status of the procedure.
Possible values include NULL
(Success), 'U’” (Unexpected Error), or
'E’ (Expected Error).
X_Message_Data ouT VARCHAR?2 | Contains the error message if

Return_Status is U’ or 'E’. Is NULL
if Return_Status=NULL.

Table 2 -18 Business Message Display Procedure Parameters (Page 1 of 1)
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Custom Populate Descriptive Flex Poplist Extension

Customize this extension to create poplists that contain values you
define. See: Setting Up Descriptive Flexfields: page 1-11.

The extension includes the following items:

Item

Name

Body template

PAPSSDFB.pls

Specification template

PAPSSDFS.pls

Package

PA_CLIENT_EXTN_SST _DFF

Procedure

POPULATEDFLEXPOPLIST

Table 2 -19 Custom Populate Descriptive Flex Poplist Extension

Print and review the files before writing the extension. See: Location of
Client Extension Files: page 2-13.
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Custom Populate Descriptive Flex Poplist Procedure

The extension uses the following parameters:

Parameter Usage Type Description
P_sContextFieldCode IN VARCHAR2 Context Field Values in the
Descriptive Flexfields
Segments window
P_sSegmentName IN VARCHAR2 Window Prompt in the
Segments Summary window
p_iEnteredByPersonID IN NUMBER(10) Employee ID of person
submitting the timecard
P_sErrorStack IN VARCHAR?2 Debug string containing the
call stack
x_iNumOfPoplistElem ouT INTEGER Number of elements in the
- poplist
x_arecPoplistValues ouT POPLISTVALUE | Contents of the poplist
_ARRAY
x_sErrorType ouT VARCHAR?2 U (Unexpected Error)
E (Normal Error)
W (Warning)
S (No Errors)
X_sErrorStack ouT VARCHAR?2 Debug string containing the
call stack
x_sErrorStage ouT VARCHAR?2 Debug string describing the
- location within the body of
this procedure
x_sErrorMessage ouT VARCHAR?2 Error message

Table 2 - 20 Parameters for the Custom Populate Descriptive Flex Poplist Extension

The Poplist Value array data structure is an array of poplistvalue,

which is a record:

Attribute Type Description

strinternalValue VARCHAR2(240) | Aninternal value that is stored in
the database

strDisplayValue VARCHAR2(240) | Text displayed in the poplist

Table 2 - 21 Attributes for poplist value
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.|
Custom Default Descriptive Flex Value Extension

Customize this extension to generate custom default values based on
the ID of the person submitting the timecard, rather than the default
that you defined in the Segments window (Default Value field). See:
Set Up Global Descriptive Flexfields: page 1-20.

This extension includes the following items:

Item Name

Body template PAPSSDFB.pls

Specification template | PAPSSDFS.pls

Package PA_CLIENT_EXTN_SST_DFF

Procedure POPULATEDFLEXDEFAULT

Table 2 - 22 Custom Default Descriptive Flex Poplist Extension

Print and review the files before writing the extension. See: Location of
Client Extension Files: page 2-13.
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Custom Default Descriptive Flex Value Procedure

The extension uses the following parameters:

Parameter

Usage

Type

Description

P_sContextFieldCode

IN

VARCHAR?2

Context Field Values in the
Descriptive Flexfields
Segments window

P_sSegmentName

VARCHAR?2

Window Prompt in the
Segments Summary window

p_iEnteredByPersonID

NUMBER(10)

Employee ID of person
submitting the timecard

P_sErrorStack

VARCHAR?2

Debug string containing the
call stack

x_sDefaultValue

ouT

VARCHAR?2

Default value for the
segment P_sSegmentName
in context
P_sContextFieldcode

X_SErrorType

ouT

VARCHAR?2

U (Unexpected Error)
E (Normal Error)

W (Warning)

S (No Errors)

X_sErrorStack

ouT

VARCHAR2

Debug string containing the
call stack

X_sErrorStage

ouT

VARCHAR?2

Debug string describing the
location within the body of
this procedure

X_sErrorMessage

ouT

VARCHAR?2

Error message

Table 2 - 23 Parameters for the Custom Default Descriptive Flex Poplist Extension

Customizing Self-Service Time 2-27




2-28 Oracle Self-Service Time Implementation Guide



CHAPTER

3 AP Timecard Approval
Workflow

T his chapter describes the AP Timecard Approval Workflow
process and tells you how to implement the workflow.
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PA Timecard Approval Workflow

See Also

When an employee submits a timecard in Self-Service Time, the
Workflow Engine initiates the PA Timecard Approval workflow. This
workflow consists of several connected processes that send
notifications to managers and employees, ensure timecards adhere to
company policy, and check manager approval levels.

You can modify the predefined workflow process by defining any
company-specific policies that your business requires.

This section describes the PA Timecard Approval workflow definition.

Note: You can modify some notifications, timeouts, and
messages within the workflow. For additional information,
refer to the Oracle Workflow Guide.

Summary of the PA Timecard Approval Workflow: page 3-2
Configuring Notifications: page 3-25
Configuring Item Attributes: page 3-27

Configuring Messages: page 3-28

Summary of the PA Timecard Approval Workflow

The PA Timecard Approval workflow is made up of processes,
functions, notifications, item attributes, and messages. When an
employee submits a timecard in Self-Service Expenses, the default
approval process performs the following:

1. Check if timecard is approved automatically (PA: Auto Approve
Timesheets = Yes). If itis, the workflow ends with a result of
Approved.

2. If the timecard requires approval, the Find Approver function uses
business rules you defined during implementation to route the
timecard to an approver. By default, the overriding approver is
checked first. If no overriding approver is specified, then the
approver is found based on the Routing extension. By default, the
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routing extension is set to find the employee’s supervisor as
defined in Human Resources. See: Using Client Extensions to
Customize Self-Service Time: page 2-12.

3. If an approver is found, workflow sends the approver a notification
requesting review of the timecard and a response. Valid responses
include Approved or Rejected. If no approver is found, the process
sends a notification to the workflow administrator who resolves
the problem so the process can continue.

4. If the response is Approved, the process verifies the approver has
the authority to approve the timecard. If not, the timecard is
routed for further approval via the Routing extension.

5. The workflow ends when the timecard is either approved or
rejected.

The PA Timecard Approval workflow contains the following processes:
e Timecard Approval Top Process: page 3-4
* Approval Process: page 3-6
* Request Approval Process: page 3-12
¢ No Manager Response Process: page 3-17
« Rejection Process: page 3-20

e Handle Transferred Approval Process: page 3-22
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Timecard Approval Top Process

The Timecard Approval Top process is a top level process that contains
all of the sub—processes within the PA Timecard Approval workflow.
This process has a result type of Approval and can be run as a top-level
process. This process is initiated when an employee submits a

timecard for approval using Self-Service Time.
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Figure 3 -1 Timecard Approval Top Process

Timecard Approval Top Process Activities

3-4

This section describes each activity in the Timecard Approval Top
process, listed by the activity’s display name. Each node corresponds

to the workflow icons that appear in Figure 3 — 1.

Start (Node 1)

This standard function activity simply marks the start of the process.

Function WF_STANDARD.NOOP
Result Type None

Required Yes

Pre(eggisite None

Activities
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Approval Process (Node 2)

This process manages the timecard approval process. If it is approved,
the process assigns the timecard a status of Approved and the process
ends. See: Approval Process: page 3-6.

If the timecard is rejected, the process transitions to the Rejection
process. See: Rejection Process: page 3-20.

Result Type Approval
Required Yes
Prerequisite Start
Activities

Rejection Process (Node 3)

This process is called when a manager rejects a timecard. The Rejection
process informs the preparer of the rejection via a notification then
waits a specified period of time for the preparer to resubmit the
timecard for approval. If the preparer does not resubmit the timecard
within the period of time specified by the Wait function activity, the
process assigns a status of rejected to the timecard and the workflow
ends.

See: Rejection Process: page 3-20.

Result Type PA Timecard Post Rejection Action
Required No

Prerequisite Start, Approval Process

Activities

End (Nodes 4 and 5)

This standard function activity simply marks the end of the process.
Although the activity itself does not have a result type, each node of
this activity in the process must have a process result assigned to it.
The process result is assigned in the property page of the activity node.

Function WF_STANDARD.NOOP
Result Type None

Prerequisite Start

Activities
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Approval Process

The Approval Process is a subprocess of the Timecard Approval Top
process and contains activities that manage the approval process. This
process includes finding an approver, sending various notifications to
both the preparer and approver(s), transferring approval responsibility
to another manager (if necessary) and assigning a status of either
Approved or Rejected.

This process cannot be initiated as a top-level process; it can only be
run as a subprocess when called by another, higher level process (in
this case, the Timecard Approval Top process). To view the properties
of the Approval process, select the process in the navigator tree, then
choose Properties from the Edit menu.
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Figure 3 -2 Approval Process

Approval Process Activities

This section describes each activity in the Approval process, listed by
the activity’s display name. Each node corresponds to the workflow
icons that appear in Figure 3 - 2.

Start (Node 1)

This standard function activity simply marks the start of the process.
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Function WF_STANDARD.NOOP

Result Type None
Required Yes
Prerequisite None
Activities

Is Employee Equal To Preparer? (Node 2)

This function activity determines whether the preparer submitted the
timecard to report her own hours or on behalf of someone else.
Employees who can submit timecards for other employees are called
authorized delegates.

If the timecard is reporting the preparer’s hours, the workflow
transitions to the Autoapprove function activity. Otherwise, the
process sends a notification to the employee whose hours the timecard
represents and then transitions to the Autoapprove activity.

Function PA_SELF_SERVICE_WF_PKG.EmployeeEqualTo
Preparer

Result Type Yes/No

Required Yes

Prerequisite Start

Activities

Inform Employee About Timecard Submission (Node 3)

This activity sends a notification to an employee when an authorized
delegate submits a timecard for the employee. The notification
contains the employee’s name, the preparer’s name, the number of
hours reported in the timecard, and any comments.

Result Type None

Message Inform Employee about Timecard Submission
Required No

Prerequisite Start, Is Employee Same as Preparer
Activities
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AutoApprove (Node 4)

This activity checks the setting of the profile option PA: AutoApprove
Timesheets to determine whether the timecard can be approved
automatically (see: PA: AutoApprove Timesheets: page 1-10). If the
profile option is set to No, the process transitions to the Find Approver
activity. Otherwise, the process notifies the preparer that the timecard
has been approved, assigns the timecard a status of Approved, and the
process ends.

Function PA_SELF_SERVICE_WF_PKG.AutoApprove
Result Type Yes/No

Required Yes

Prerequisite Start, Is Employee Same as Preparer
Activities

Inform Preparer Timecard AutoApproved (Node 5)

This activity notifies the person who created the timecard that it was
approved automatically.

Message Inform Preparer Timecard AutoApproved

Result Type None

Required No

Prerequisite Start, Is Employee Same as Preparer, AutoApprove
Activities

Find Approver (Node 6)

This function activity identifies the approver for the timecard. If this
activity cannot identify an approver, it notifies the system
administrator. Otherwise, the process transitions to the Request
Approval process: page 3-12.

Function PA_SELF SERVICE_WF_PKG.FindApprover
Result Type PA Timecard Approver Search Result

Required Yes (if AutoApprove returns No)

Prerequisite Start, Is Employee Same as Preparer, AutoApprove
Activities
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Notify System Administrator — No Approver (Node 7)

This activity notifies the system administrator when the Find Approver
function activity fails to identify an approver for the timecard. After
the system administrator corrects the error and responds by clicking
Problem Fixed in the notification, the process transitions to the Request
Approval process.

Message Notify System Administrator — No Approver
Result Type PA Timecard Problem Fixed Status

Required No

Prerequisite Start, Is Employee Same as Preparer,
Activities AutoApprove, Find Approver

Record Forward From Info (Node 8)

This function activity records approver information when all of the
following are true:

« the timecard is approved
« the approver does not have sufficient authority

* responsibility for approving the timecard has not been

transferred

Function PA _SELF SERVICE_WF_PKG.RecordForwardFrom
Info

Result Type PA Timecard Activity Result

Required No

Prerequisite Start, Is Employee Same as Preparer,

Activities AutoApprove, Find Approver, Request Approval
Process, Verify Authority, Has Timecard Been
Transferred

Request Approval Process (Node 9)

This process routes the timecard to approvers for review. See: Request
Approval Process: page 3-12.

Result Type Approval
Required Yes (if the AutoApprove activity returns No)
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Prerequisite Start, Is Employee Same as Preparer,
Activities AutoApprove, Find Approver

Handle Transferred Approval (Node 10)

This process records information about the new approver when the
original approver transfers approval responsibility to another manager.
It also notifies the preparer that the original approver was not
authorized to approve the timecard and that the timecard was sent to
another manager for approval.

Result Type Approval

Required Yes if approval was transferred to another manager
because the original approver was not authorized
to approve the timecard; otherwise, no.

Prerequisite Start, Is Employee Same as Preparer,

Activities AutoApprove, Find Approver, Request Approval
Process, Verify Authority, Has Timecard Been
Transferred

Is Timecard Transferred (Node 11)

This function activity checks whether the responsibility for approving
the timecard has been transferred to another approver. If approval
responsibility was transferred, workflow transitions to the Handle
Transferred Approval process. Otherwise, it transitions to the Record
Forward From info function activity (Node 8 in Figure 3 - 2).

Function PA_SELF SERVICE _WF_PKG.Transferred

Result Type Yes/No

Required Yes (if Verify Authority function fails; otherwise,
no)

Prerequisite Start, Is Employee Same as Preparer,

Activities AutoApprove, Find Approver, Request Approval

Process, Verify Authority

Verify Authority (Node 12)

This function activity determines whether the person who approved
the timecard has the proper level of authority to do so. If the approver
is authorized to approve the timecard, the process notifies the preparer
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that the timecard has been approved. Otherwise, the process checks
whether the timecard has been transferred to another approver.

Function PA SELF SERVICE WF_PKG.VerifyAuthority

Result Type PA Timecard Activity Result (Pass/Fail)

Required Yes (if the AutoApprove activity returns No)

Prerequisite Start, Is Employee Same as Preparer,

Activities AutoApprove, Find Approver, Request Approval
Process

Inform Preparer of Timecard Approval (Node 13)

This activity notifies the preparer that the timecard has been approved.

Message Inform Preparer of Timecard Approval

Result Type None

Required Yes

Prerequisite Start, Is Employee Same as Preparer,

Activities AutoApprove, Find Approver, Request Approval

Process, Verify Authority

Mark Timecard as Approved and Set Batch Name (Node 14)

This function activity sets the status of the timecard to Approved and
assigns a unique batch name to the timecard. This activity is called
regardless of whether the timecard is approved manually or
automatically.

Function PA_SELF_SERVICE_WF_PKG.Approved

Result Type None

Required Yes if timecard is approved; otherwise, no.
Prerequisite Start, Is Employee Same as Preparer,

Activities AutoApprove, Find Approver, Request Approval

Process, Verify Authority, Inform Preparer of
Timecard Approval

End (Nodes 15 and 16)

This standard function activity simply marks the end of the process.
Although the activity itself does not have a result type, each node of
this activity in the process must have a process result assigned to it.
The process result is assigned in the property page of the activity node.
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Function WF_STANDARD.NOOP

Result Type None
Prerequisite Start
Activities

Request Approval Process

The Request Approval process is a subprocess of the Approval process
and contains activities that route the timecard for approval. This
process sends notifications, requests approval from the specified
approver, and — depending on the action taken by the approver —
assigns a status of either Approved or Rejected to the timecard.

This process cannot be initiated as a top-level process; it can only be
run as a subprocess when called by another, higher level process (in
this case, the Approval process). To view the properties of the Request
Approval process, select the process in the navigator tree, then choose
Properties from the Edit menu.

3-12 Oracle Self-Service Time Implementation Guide



=

CLC Direct td anager

| Exit E
EE———
o L
Loop Cournter Mo Manager
Responze Process

|z Apprower the
[virect Manager of
the Emplayes 7

< Timeout:

Start

B | - >
Mo No M Approved
First Approser ? |5 timecand Request Approval End [Approved)
fonwarded to anather from approser
apprower ¢ @
Fejected . @
o

Inform Preparer
Timecard Forwarded

Figure 3 - 3 Request Approval Process

Request Approval Process Activities

This section describes each activity in the Request Approval process,
listed by the activity’s display name. Each node corresponds to the
workflow icons that appear in Figure 3 - 3.

Start (Node 1)

This standard function activity simply marks the start of the process.

Function WF_STANDARD.NOOP
Result Type None

Required Yes

Pre(egl_Jisite None

Activities
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First Approver (Node 2)

This function activity determines whether the timecard must be sent to
the first approver (for example, the employee’s direct manager) or
someone with a higher approval limit.

Function PA_SELF_SERVICE_WF_PKG.FirstApprover
Result Type Yes/No

Required Yes

PreregL_Jisite Start

Activities

Is Approver the Direct Manager of the Employee (Node 3)

If the First Approver activity returns Yes, this function activity
determines whether the approver is the employee’s direct manager. If
the result is Yes, the process notifies the manager that the timecard is
available for review. Otherwise, a “request approval” notification is
sent to the approver and the employee’s direct manager receives a copy
of the notification for informational purposes.

Function PA_SELF_SERVICE_WF_PKG.IsApproverManager

Result Type Yes/No

Required Yes if the First Approver activity returns Yes;
otherwise, not required.

Prerequisite Start, First Approver

Activities

CC Direct Manager (Node 4)

This activity notifies the preparer’s direct manager that the timecard
has been sent to another person for approval.

Message CC Direct Manager

Result Type None

Required Yes if timecard is sent to someone other than the
preparer’s direct manager for approval; otherwise,
no.

Prerequisite Start, First Approver, Is Approver the Direct

Activities Manager of the Employee
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Is Timecard Forwarded to Another Approver (Node 5)

If the First Approver activity returns No, this function activity
determines whether the timecard was forwarded to someone other
than the preparer’s direct manager for approval.

Function PA_SELF_SERVICE_WF_PKG.ApprovalForwarded

Result Type Yes/No

Required Yes if the First Approver activity returns No;
otherwise, not required.

Prerequisite Start, First Approver

Activities

Inform Preparer Timecard Forwarded (Node 6)

This activity notifies the preparer when the timecard is forwarded to
someone other than the preparer’s direct manager for approval.

Message Inform Preparer Timecard Forwarded

Result Type None

Required Yes if timecard is forwarded to another approver;
otherwise, no.

Prerequisite Start, First Approver, Is Timecard Forwarded to

Activities Another Approver

Request Approval from Approver (Node 7)

This activity notifies a manager that a timecard requires review.

Message Request Approval from Approver

Function PA_SELF SERVICE _WF_PKG.SetTransferInfo
Result Type Approval

Required Yes

Prerequisite Start, First Approver, Is Timecard Forwarded to
Activities Another Approver

Loop Counter (Node 8)

This is a standard function activity that limits the number of times the
Workflow Engine transitions through the Request Approval From
Approver notification activity. You can define how many times the
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approver is notified by entering a number for the Loop Limit activity
attribute of the Loop Counter activity.

Function WF_STANDARD.LOOPCOUNTER
Result Type Loop Counter

Required No

Prerequisite Start, First Approver

Activities

No Manager Response Process (Node 9)

This process notifies the preparer when a manager fails to approve or
reject a timecard within a specific period of time. The No Manager
Response process also forwards the request to the next approver in the
management chain. See: No Manager Response Process: page 3-17.

Result Type None

Required No

Prerequisite Start, First Approver, Is Timecard Forwarded to

Activities Another Approver, Request Approval From
Approver

End (Nodes 10 and 11)

This standard function activity simply marks the end of the process.
Although the activity itself does not have a result type, each node of
this activity in the process must have a process result assigned to it.
The process result is assigned in the property page of the activity node.

Function WF_STANDARD.NOOP
Result Type None

Prerequisite Start

Activities
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No Manager Response Process

The No Manager Response process is a subprocess of the Request
Approval process that notifies the preparer when a manager fails to
approve or reject a timecard within a specific period of time and then
forwards the request to the next approver in the management chain.

This process cannot be initiated as a top-level process; it can only be
run as a subprocess when called by another, higher level process (the
Request Approval process). To view the properties of the No Manager
Response process, select the process in the navigator tree, then choose
Properties from the Edit menu.
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Figure 3 -4 No Manager Response Process

No Manager Response Process Activities

This section describes each activity in the No Manager Response
process, listed by the activity’s display name. Each node corresponds
to the workflow icons that appear in Figure 3 - 4.

Start (Node 1)

This standard function activity simply marks the start of the process.
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Function WF_STANDARD.NOOP

Result Type None
Required Yes
Prerequisite None
Activities

Notify Preparer — No Manager Response (Node 2)

This activity notifies the preparer when a manager does not respond to
the preparer’s request to approve a timecard. This activity also
forwards the timecard to the next approver in the management chain.

Message Notify Preparer — No Manager Response
Result Type PA Timecard Approval Selection
Required Yes

Pre(egt_Jisite Start

Activities

Noop (Node 3)

This is a standard function activity that acts as a placeholder. It
performs no action.

Function WF_STANDARD.NOOP

Result Type None

Required No

Prerequisite Start, Notify Preparer — No Manager Response
Activities

Record Forward From Info (Node 4)

This function activity records information about the original approver
when that approver fails to respond to the Request Approval
notification and then transitions to the Find Approver activity.

Function PA_SELF SERVICE WF_PKG.RecordForwardFrom
Info

Result Type None

Required Yes

Prerequisite Start, Notify Preparer — No Manager Response

Activities
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Find Approver (Node 5)

This function activity determines to which manager to forward the
timecard when the original approver fails to respond to the Request
Approval from Approver notification.

Function PA_SELF_SERVICE_WF_PKG.FindApprover
Result Type PA Timecard Approver Search Result
Required Yes

Prerequisite Start, Notify Preparer — No Manager Response,
Activities Record Forward From Info

Notify System Administrator — No Approver (Node 6)

This activity notifies the system administrator when an approver for
the timecard cannot be found. When the system administrator
responds by choosing Problem Fixed in the notification, the process
continues.

Message Notify System Administrator — No Approver
Result Type PA Timecard Problem Fixed Status

Required Yes

Prerequisite Start, Notify Preparer — No Manager Response,
Activities Record Forward From Info, Find Approver

End (Node 7)

This standard function activity simply marks the end of the process.
Although the activity itself does not have a result type, each node of
this activity in the process must have a process result assigned to it.
The process result is assigned in the property page of the activity node.

Function WF_STANDARD.NOOP
Result Type None

Prerequisite Start

Activities
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Rejection Process

The Rejection Response process is a subprocess of the Timecard
Approval Top process that notifies the preparer when a timecard is
rejected and sets the status of the timecard to Rejected.

This process cannot be initiated as a top-level process; it can only be
run as a subprocess when called by another, higher level process (the
Timecard Approval Top process). To view the properties of the
Rejection process, select the process in the navigator tree, then choose
Properties from the Edit menu.
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Figure 3 - 5 Rejection Process

Rejection Process Activities

This section describes each activity in the No Manager Response
process, listed by the activity’s display name. Each node corresponds
to the workflow icons that appear in Figure 3 - 5.

Start (Node 1)

This standard function activity simply marks the start of the process.

Function WF_STANDARD.NOOP
Result Type None

Required Yes

Pre(egt_Jisite None

Activities
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Inform Preparer of Timecard Rejection (Node 2)

This activity notifies the preparer when a timecard is rejected.

Message Inform Preparer of Timecard Rejection
Result Type None

Required Yes

Prerequisite Start

Activities

Set Reject Status and Reset Attributes (Node 3)

This function activity sets the status of the timecard to Rejected and
resets all other associated attributes.

Function PA SELF SERVICE WF_PKG.Rejected
Result Type None

Required Yes

Prerequisite Start, Inform Preparer of Timecard Rejection
Activities

Wait (Node 4)

This is a standard function activity that pauses the Rejection process
until the employee fixes and resubmits the timecard for approval. If a
rejected timecard is not resubmitted before this activity ”times out,” the
process transitions to the Delete Expense Report From Interface Tables
activity.

You can specify any combination of days, hours, and minutes before
this activity times out. For example, you can specify that employees
have thirty days to resubmit a rejected timecard before it is deleted
from the system.

To specify a timeout for the Wait function activity:
1. View the properties for the activity.
2. Select the Node tab.

3. Choose a Timeout period of Relative Time, then specify a number
of days, hours, and minutes.

4. Save your work.
Function WF_STANDARD.BLOCK
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Result Type PA Timecard Post Rejection Action

Required Yes
Prerequisite Start, Inform Preparer of Timecard Rejection, Set
Activities Reject Status and Reset Attributes

End (Nodes 5 and 6)

This standard function activity simply marks the end of the process.
Although the activity itself does not have a result type, each node of
this activity in the process must have a process result assigned to it.
The process result is assigned in the property page of the activity node.

Function WF_STANDARD.NOOP
Result Type None

Prerequisite Start

Activities

Handle Transferred Approval Process

3-22

The Handle Transferred Approval process is a subprocess of the
Approval process and is called when an approver transfers
responsibility for approving a timecard to another manager. The
process also notifies the original approver if the new approver does not
have authority to approve the timecard.

This process cannot be initiated as a top-level process; it can only be
run as a subprocess when called by another, higher level process (the
Approval process). To view the properties of the Handle Transferred
Approval process, select the process in the navigator tree, then choose
Properties from the Edit menu.
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Handle Transferred Approval Process Activities

This section describes each activity in the Handle Transferred Approval
process, listed by the activity’s display name. Each node corresponds
to the workflow icons that appear in Figure 3 - 6.

Start (Node 1)

This standard function activity simply marks the start of the process.

Function
Result Type
Required

Prerequisite
Activities

WF_STANDARD.NOOP
None
Yes

None

Notify Approver About Transferee No Authority (Node 2)

This activity notifies the original approver that the person to whom
approval responsibility was transferred is not authorized to approve

the timecard.
Message
Result Type
Required

Prerequisite
Activities

Notify Approver About Transferee No Authority
None

Yes

Start
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See Also

Clear Transfer Information (Node 3)

This function clears all transfer information before the original
approver receives the Transferee No Authority notification (Node 2).

Function PA SELF SERVICE WF_PKG.ClearTransferInfo
Result Type None

Required Yes

Prerequisite Start, Notify Approver About Transferee No
Activities Authority

End (Node 4)

This standard function activity simply marks the end of the process.
Although the activity itself does not have a result type, each node of
this activity in the process must have a process result assigned to it.
The process result is assigned in the property page of the activity node.

Function WF_STANDARD.NOOP
Result Type None

Prerequisite Start

Activities

Configuring Notifications: page 3-25
Configuring Item Attributes: page 3-27

Configuring Messages: page 3-28
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Configuring Notifications

Table 3 — 1 summarizes the Self-Service Time workflow notifications.
To specify timeout values, see: Defining Timeouts: page 3-26.

Name

Internal Name and Description

Customizable?

Default

Inform employee about
timecard submission

NTFY_TIMECARD_SUBMITTED

Notifies an employee when
someone else submits timecard
on their behalf Does not require
employee action.

No

CC Direct Manager

NTFY_DIRECT_MANAGER

This notification is sent when the
approver is not the employee’s
direct manager. It notifies the
direct manager that employee
submitted a timecard.

No

Notify Preparer — No
Approver Response

NTFY_NO_RESPONSE

If the preparer doesn’t respond to
the No approver response
notification (by sending to the
next approver or resending to
approver within the timeout
period), the preparer is notified
again.

No (Timeout)

Inform Preparer of
Timecard Approval

NTFY_TCARD_APPROVED

This notification is sent when
timecard is approved by
approver. Does not require
employee action.

No

Inform Preparer of
Timecard Rejection

NTFY_TCARD_REJECTED

This notification is sent when a
timecard is rejected by an
approver. Does not require
employee action.

No

Inform Preparer
Timecard Forwarded

NOTIFY_TCARD_FORWARDED

This notification is sent when a
timecard is routed from one
approver to another. Does not
require employee action.

No

Inform Preparer
Timecard
Autoapproved

NTFY_TCARD_AUTO_
APPROVED

Informs the preparer that the
timecard was approved
automatically

No

Notify System
Administrator - No
Approver

NTFY_NO_APPROVER_FOUND

This notification is sent when no
approver is found. After the
timeout period, it attempts to
find next approver.

No

Table 3-1 Workflow Notifications (Page 1 of 2)
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Customizable?

Default

Transferee Not
Authorized to Approve

AUTHORIZED

Informs the preparer that the
person to whom the timecard was
transferred is not authorized to
approve it.

Name Internal Name and Description
Request Approval From | NTFY_APPROVER No
Approver This notification is sent to the
approver for approval/rejection.
Notify Approver NTFY_TRANSFEREE_NOT_ No

Table 3-1 Workflow Notifications (Page 2 of 2)

Defining Timeouts

3-26

You can specify the period of time that must pass before a notification

activity times out. Following are the timeouts you can modify:

e Timeout After No System Administrator Response

e Timeout After
e Timeout After

p To define a timeout:

No Approver Response

No Preparer Response

1. Inthe Workflow Builder, open the database (File > Open).

2. Open the PA Timecard Approval workflow file.
3. Expand the Attributes branch, then select the timeout to modify.
4

In the Default Value field, enter a number of minutes for the

timeout. For example, to set a timeout of five days, set the Default
Value to 7200 (one day = 1440 minutes, therefore 5 x 1440 = 7200).

5. Choose Apply to save your work.
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Configuring Item Attributes

You can configure the following item attributes:

¢ Notify Resend Limit sets the maximum number of times the
notification Request Approval from Approver is resent if there is
no response from the approver. The default value is 3.

« Workflow Administrator specifies who receives a notification if
no approver is found during the workflow process.

p To set the Notify Resend Limit item attribute:

1.

N o g &~ »w

In the Workflow Builder, open the database (File > Open).

If not already loaded, move PA Timecard Approval from the
Hidden window to the visible window. Click OK.

Expand PA Timecard Approval.
Expand Attributes.

Click Notification Resend Limit.
Select the Details tab.

Enter the timeout period in days, hours, and minutes.

» To configure Workflow Administrator item attribute:

1.
2.

N g A~

In the Workflow Builder, open the database (File > Open).

Load Roles from Database (Find > Load Roles From Database).
Click the Find button and enter the name of your workflow
administrator. Click OK.

Move PA Timecard Approval from the Hidden window to the
visible window. Click OK.

Expand PA Timecard Approval.
Expand Attributes.
Click System Administrator.

In the Default Value field, select the person from the poplists. Click
OK, and then choose File > Save.
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Configuring Messages

You can change the body of workflow messages. However, you cannot
create additional attributes.

» Tochange the message body:
1. Inthe Workflow Builder, open the database (File > Open).

2. If not already loaded, move PA Timecard Approval from the
Hidden window to the visible window. Click OK.

Expand PA Timecard Approval.
Expand the Messages branch.
Select a message.

Select the body tab.

N g &~ w

Change the text as needed.
For example, you can change the message body from

This timecard was submitted to &ZAPPROVER_DISP_NAME for
approval.

to

Self-Service Time sent the timecard you submitted to
&APPROVER_DISP_NAME for approval.
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